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CERNER PATIENT ACCOUNTING OVERVIEW PARTICIPANT GUIDE 

WELCOME! 

Information contained within this document has been compiled from various Wiki articles and largely extracted 

from Cerner Patient Accounting Overview Participant Guide Wiki article: Cerner Patient Accounting Overview. 

Wiki’s are resource articles provided by Cerner, and the information contain wherein this document is up to 

date as of March 2020. 

HOW TO USE THIS GUIDE 

In its electronic version the Table of Contents below is clickable. Hover over the title that you wish to navigate 

to and Ctrl + Click to follow the link. Press Ctrl + Home to return to the first page. 

You may also use click Ctrl + F to search this document. Use the search field or the Navigation feature to search 

by: 

• Headings 

• Pages 

• Results  

 

  

https://wiki.ucern.com/pages/viewpage.action?pageId=1392972264&bookId=8159
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INTRODUCING PATIENT ACCOUNTING 

GETTING STARTED 

You can review a patient account primarily from the Cerner Revenue Cycle solution. This solution provides perspectives on the 

essential information you need for completing your daily work. The information available includes:  

• Patient Accounting 

• Visits 

• Registration 

• Charges 

• Work queues and how to manage tasks in the queue 

• Assign a Self-Pay Patient Account to Collections 

• Generate a Claim On-demand 

• Edit a Claim 

• Revenue Cycle’s Financial Combine Ability to Merge Encounters 

• Use Move Charges to Combine Charges from One Account to Another 

• Manually Work a Late Charge using Bill Late Charges 

• Apply a Rate Code for Skilled Nursing Facilities 

• View and Modify General Ledger Entries 

  

As you review a patient account it will be important to: 

o Select the correct encounter when viewing information related to a specific visit 

o Be aware of the context of the information that you are viewing 

o Be aware of where you are in the hierarchy so that you can account for the information displayed 

▪ The Navigation Bar, also sometimes called “breadcrumbs,” can help you track what you are looking at in 

the patient account.  

As a reviewer, what you see in Revenue Cycle will be a sufficient summary and you will not need to log into other solutions.  

 

You will use work queues to manage the variety of activity on accounts.  
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LOGGING IN AND OUT OF REVENUE CYCLE  

Log In 

Complete the following steps to log in to Revenue Cycle: 

1. Click the Revenue Cycle button on the desktop. 

2. At the log-in window, enter your username in the User Name box.  

 

 

3. Enter your password into the Password box. 

4. Click OK or press Enter.  

Log Out 

After you finish using Revenue Cycle, remember to log out of the application. To log out, click the Exit button on the toolbar 

or navigate to the File menu and select Exit.  

 

 

NOTE: IT IS IMPORTANT TO ALWAYS LOG OUT. THIS IS TO ENSURE THE INTEGRITY AND PRIVACY OF PATIENT 

RECORDS AND TO DETER UNAUTHORIZED ACCESS THROUGH YOUR USER ACCOUNT. 
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FRAMEWORK OVERVIEW 

When the application is opened, the name of the application and the current perspective will display in the title bar.  

 

 
 

 
 

 

TOOLBAR (PATIENT-SPECIFIC PERSPECTIVES)  

The toolbar gives you access to patient-specific perspectives. These options are available only when you are in the context of a 

patient. The perspectives displayed are based on your security access. If you do not have security access to a perspective, it is not 

displayed on the toolbar. 

The following perspectives are available on the toolbar: 

Button Name and Action 

 

The Appointments perspective is where appointments can be made or modified. The following views are 

available in the Appointments perspective: 

• Future appointments 

• Past Appointments 

• Standby Requests 

• Appointment Requests 

• Patient Cases 

• Health Maintenance 

 

The Registration perspective is patient-level registration. The following views are available in the 

Registration perspective: 

• Demographics  
o Patient 
o Relationship 
o Guarantor 
o Insurance 
o Alerts 

• Guarantor Balance Summary 

• Patient Cases 
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The Encounters perspective displays all encounters for patients. The following views are available in the 

Encounters perspective: 

• Encounters 

• Patient Cases 

• Encounter Details  
o Details 
o Guarantor 
o Insurance 

 

The Patient Account perspective displays the billing elements. This perspective displays information at the 

person-level, patient account-level, encounter-level, and so on. This perspective also displays balances, 

claims, statements, insurance or self-pay transactions, billing holds, refunds, and other information. The 

Patient Account perspective contains comprehensive information associated with patient balances. 

 

The Charge Entry perspective allows you to manually enter charges for specific patients. 

NAVIGATION PANE (NON-PATIENT PERSPECTIVES) 

The navigation pane on the left side of the application gives you access to non patient-specific perspectives. These options are 

available regardless patient context. The perspectives displayed are based on your security access. If you do not have security access 

to a perspective, it is not displayed. 

The following perspectives are available in the navigation pane: 

Button Name and Action 

 

Patient Tracking perspective: Displays all appointments scheduled for a location for the day. You can filter to two hours, 

four hours, or all day. Additionally, the check-in process can be completed in this perspective. 

 

Resource perspective: Allows you to view a provider's calendar. You can place blocks for providers so that appointments 

are not scheduled for that time frame. The following views are available in this perspective:  

• Resource View 

• Multi Day View 

• Availability View 

• Resource Schedule 
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Queues perspective: This perspective contains queues that are typically be worked by patient access staff. The following 

views are available in this perspective:  

• Reschedule Requests 

• Standby Appointment Requests 

• Eligibility 

• Consumer Demographic Updates 

• Appointment Requests 

• Work Queues 

• Requests 

 

My Workflow perspective: - Queues in this perspective are typically worked by billing staff:  

• Reports 

• Follow-up 

• Workflow 

• Remittances 

 

Charge Batch Entry perspective: Allows you to manually enter charges for multiple accounts or encounters. 

 

Create Remittance perspective: Allows you to create or view current remittances. 
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TOOLBAR BUTTONS 

The Revenue Cycle toolbar contains the following elements: 

Button Action 

 

Search Opens the Person Search window and allows you to locate a patient record. Click beside the 

Find button to select the search filter you want to enter in the search box (such as Name or MRN) and to 

select the perspective you want to open after you have selected a patient. 

 

Charge Entry Allows you to enter specific charges for a patient whose record is open. 

 

Patient Account Opens the Patient Account perspective and allows you to manage account information. 

 

Appointments Opens the Appointments perspective and allows you to create appointments. This patient-

specific perspective contains Future Appointments, Past Appointments, Requests, Add Appointment, 

Demographic Summary, Balance Summary, and Guarantors views. It is recommended for adding or 

modifying appointments and verifying patient demographic information. 

 

Check In/Out Opens the Check In/Out perspective and allows you to take actions on the selected patient. 

(You can perform the actual checking in and out or indicate a no show from the patient list in Patient 

Tracking). This patient-specific perspective contains the Demographic Banner, Demographic Summary, 

Future Appointments, Past Appointments, Encounter Summary, Insurance Summary, Guarantors, and 

Add Appointment views. This perspective is recommended for when the patient arrives and also when 

they depart. 

 

Registration Opens the Registration perspective and allows you to view, enter, or modify patient, related 

person, guarantor, employer, and insurance information. 

 

Encounters Opens the Encounters perspective and allows you to add an encounter and enter information 

about the encounter. You can also view details for a selected encounter. This perspective is 

recommended for monitoring and maintaining the encounter information associated to the patient, 

including submitting and viewing eligibility and benefits. 

 

Open View Allows you to open a selected view. The views available for selection depend on the 

perspective that is currently open. 

 

Allows you to open a perspective with a menu command instead of a toolbar button. You can select Keep 

Open when you have a patient record open (for up to a maximum of five records). The patient name 

remains on the toolbar when you open a different record. You can click the name to retrieve the record 

you were looking at previously. If you click Close, the patient record is closed. 

 

My Workflow Allows you to view work lists to facilitate patient accounts. 

 

Charge Batch Entry Allows you to enter charges in batch. 

 

Patient Tracking Allows you to view a patient list of patients with scheduled appointments for today and 

take the following actions: check a patient in and out, no show a patient, and track wait times. It is 
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recommended for use at the front desk and nurse stations to keep track of the patient while they are in 

the office. 

 

Resource View Allows you to select a resource and view and maintain its schedule. It can be used to start 

the process of scheduling a patient. 

 

Appointment Queues Allows you to select a date range and resource and then view a list of 

appointments that must be rescheduled or canceled. There are separate views for displaced 

appointments and standby appointments. It is recommended for managing appointments and for 

patients needing further action. 

 

Consumer Activity Allows you to update patient information without having to open each individual 

record. 

 

Alerts Allows you to schedule persons on a standby list. When you click Alerts on the toolbar, a list of 

persons on standby who can be scheduled now is displayed. Select a person from the list, and the 

Appointments perspective is opened. If you do not set up standby preferences, you will not get alerts. 

 

Create New Remittance Opens the Create New Remittance dialog box. 

 

 

PREVIEW PANE 

The Preview is available in a throughout the application and when opened it will display additional information. It’s denoted  by the 

following icons  

The single arrow will display some information  

The arrow and bar will display all available information  

MENUS 

The Revenue Cycle menus are like those of any traditional Microsoft Windows-based application. You can interact with items directly 

in the Revenue Cycle window, or you can use the menus to select similar options. 

The View Menu in Revenue Cycle includes the following commands: 

Command Action 

Open 

Perspective 
Allows you to open a perspective. Note that the available perspectives change if a patient record is open. 

Open View 
Allows you to select a view to be displayed in the perspective. Note that the available views flex based on the 

perspective that is currently open. 

/display/rcaHP/Setting+Preferences+in+Revenue+Cycle
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Perspective 

Layout 

• Restore: Displays the default views for a perspective if you make changes but have not saved them. Use 
this option if you have minimized or maximized views in the perspective and want to return to the 
default.  

• Save: Allows you to save the current perspective layout as your personal default. If you move to a 
different perspective or close and reopen the application, the saved perspective retains your changes 
when you return to it. 

• Reset: Allows you to return to the default views for each perspective. 

• Save Configuration: Saves the current layout and applies it to all users in your domain. Typically, only a 
system administrator has access to this command. 

• Reset Configuration: Resets the layout to the default configuration for all users in your domain. 
Typically, only a system administrator has access to this command.  

 

FILE MENU 

The File menu contains the following options: 

• Open Patient Record: Opens Person Search and allows you to locate a patient record. Use this option to select a patient 

and open their record. 

• Close Patient Record: Closes the patient record that is currently open. 

• Preferences: Opens the Preferences window, allowing you to set user-specific preferences for registration, scheduling, 

patient tracking, batch charge entry, and remittance posting. 

• Change Password: Allows you to change your password. Enter your current password, then your new password. Retype the 

new password to confirm and click OK. The next time you open Revenue Cycle, use your newly created password to sign in. 

• Recent Patient Records: Displays the last ten patients you have accessed. This is maintained while you are signed in but is 

cleared when you sign out. 

• Exit: Use this option to close Revenue Cycle.  

 

 

 

VIEW MENU 

The View menu contains the following options: 
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• Open Perspective: Allows you to open a selected perspective. The perspectives available for selection depend on whether a 

patient-specific record is open.  

 
• Open View: Allows you to open a selected view. The views available for selection depend on the perspective that is 

currently open.  

 
• Perspective Layout: This option presents the following submenus: 

o Restore: Use this option if you have minimized or maximized views in the perspective and want to return them to 

the default. Displays default views for a perspective if you make changes but have not saved them. 

o Save: Allows you to save the current perspective layout as your personal default. If you move to a different 

perspective or close and reopen the application, the saved perspective retains your changes when you return to it. 

This command applies to an individual user. 

o Reset: Allows you to return to the default views for each perspective. This command applies to an individual user. 

o Save Configuration: Saves the current layout and applies it to all users in your domain. Typically, only a system 

administrator has access to this command. 

o Reset Configuration: Resets the layout to the default configuration for all users in your domain. Typically, only a 

system administrator has access to this command.  

 

 

TASK MENU 

The Task menu contains following options: 
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• Accounting: Use this option to access the following submenus:  

o Charge Batch Entry: Enter a single charge or credit or a batch of charges or credits for one or more patients. 

o Charge Viewer: Audit and modify charges that have been generated for your institution. 

 

• Reports: Use this option to open Discern Analytics 2.0, Discern Explorer, or Scheduling Reports.  

 

 

• Locks: If another user is accessing the same patient you have selected, you will receive a message that an update cannot be 

saved because the person is locked. This option opens Locks Manager and allows you to determine who has the lock on the 

record and to remove the lock if appropriate. 

• PowerChart: This option launches PowerChart. If you have a person in context PowerChart opens to that patient's EMR 

record. Note that this link from Revenue Cycle to PowerChart uses Cerner's encounter best match logic. While you may 

have a specific encounter open in Revenue Cycle, that same encounter may not be the one that opens in PowerChart. Be 

sure that you have the correct encounter or you may need to select the correct one in PowerChart.  

• PM Documents — Use this option to launch Person Mgmt: Documents (PMDBDocs.exe) in order to reprint any registration 

documents as needed (for example, Face Sheet, Label, Armband, and so on). See the Document Routing Tool Help page for 

more information. 

 

 

ACTIVE PERSON DISPLAY 

In Revenue Cycle, you can keep up to five patients open at one time and can easily navigate between them. Open patients are 

displayed on the toolbar. To view patient perspectives for an open patient, expand the patient's name and select the appropriate 

perspective. From this list, you can also select Keep Open to keep a person active or select Close to close the person and remove 

him or her from the toolbar. A pin ( ) adjacent to a name indicates that Keep Open has been selected. An asterisk (*) adjacent to a 

name indicates that there is unsaved information in one of the perspectives.  

For example, you recently worked on tasks related to Patients A and B and are currently viewing the Registration perspective for 

Patient A, but need to schedule an appointment for Patient B. To do this, you could select Appointments from Patient B's menu to 

access the Appointments perspective.  

 

  

file:///C:/display/1101registrationHP/Document+Routing+Tool+Help
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WHAT DOES THE REVENUE CYCLE SOLUTION HAVE TO OFFER 

PERSPECTIVES 

A perspective is a collection of views that allow you to complete a workflow. Revenue Cycle has multiple perspectives. The Revenue 

Cycle perspectives are described below: 

CHARGE ENTRY 

The Charge Entry perspective can be accessed from the Encounters view and by clicking the Charge Entry button listed on the 

toolbar, provided preferences have been set to have it displayed there. This perspective is a patient perspective. Accessing from the 

patient account puts the patient in context when the perspective is opened. 

MY WORKFLOW 

The My Workflow perspective is an overview of work that needs to be done by you or any direct reports. You can use this 

perspective to view work items, reports, charge batches, and remittances that have been assigned to you and any of your direct 

reports. 

PATIENT ACCOUNT 

The Patient Account perspective is a collection of patient information and is used to manage the patients account information. 

Information for the entity in context is displayed in the perspective. Parent information is displayed in the top row in the upper left 

corner with the detail information in the upper right corner. Immediate children are displayed in the bottom row. Views not 

displayed but available for the perspective are also set into context. 

REMITTANCE POSTING 

This non-patient specific perspective is used to post batches of payments and adjustments that are received from payers. 

Transactions can be posted at the Claim level, claim Service Item level, Account level, Encounter level, Invoice level, and the 

Statement level. 

PATIENT TRACKING 

The Patient Tracking Perspective is recommended for use at the front desk and nurse stations for keeping track of the patient while 

they are in the office. 

WORK QUEUES PERSPECTIVE 

This Non-Patient perspective is recommended for managing appointments and for patients needing further action. 

RESOURCE VIEW PERSPE CTIVE 

The Resource View Perspective is used for viewing past or future information regarding the schedule of resources. 
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APPOINTMENTS PERSPECTIVE 

This patient-specific perspective is recommended for adding or modifying appointments and verifying patient demographic 

information. 

REGISTRATION PERSPECTIVE 

This patient-specific perspective is recommended for maintaining the patient demographic information, related persons, and 

insurance information for the patient. 

VISITS PERSPECTIVE  

This patient-specific perspective recommended for monitoring and maintaining the visit information associated to the patient, 

including submitting and viewing eligibility and benefits. 

USER PREFERENCES 

You can customize how Patient Accounting displays and inputs information to create more efficiency and consistency in your work. 

All you need to do is adjust the default settings. The preferences you set here override any similar, original configurations that a 

system administrator arranges.  

To open the Preferences window, from the File menu, select Preferences. The Preferences window is displayed 

 Contents: 

• 1 Charge Entry  

o 1.1 Field Duplication 

o 1.2 Field Skipping 

o 1.3 Line Item Override 

• 2 General  

o 2.1 Quick Search 

o 2.2 Non-Patient Perspective 

o 2.3 Patient Perspective 

• 3 Legacy Tasks 

. 
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CHARGE ENTRY 

Complete the following steps to set preferences for Charge Entry:  

1. From the Preferences window, select Charge Entry from the panel on the left. 

2. The following preferences are available for Charge Entry:  

a. Show Service Item Lookup Prompt Automatically When No Matching or Multiple Service Items Exists: This 

option is deselected by default. When this preference is enabled, the Search dialog box is displayed when you 

press ENTER when no matching or multiple service items exist. 

b. Display ASA Code Field in Charge Entry: Displays the ASA Code field. 

c. Set Diagnosis Pointer to Required When At least One ICD Diagnosis is Populated 

d. Display Line Item Override Field in Charge Entry and Charge Modify: See the Line Item Override section below for 

more information. 

e. Service Item Look-up Using list: Select the default search option for service items. The default search is CPT/HCPCs 

codes, but if you typically enter charges by CDM or ICD procedure codes, then you should select that option 

instead. All options are also available in the regular charge entry screen by clicking the arrow next to the service 

item text box. 

f. Display Service Time Along with Service Date: Selecting this preference allows a service time to be displayed in 

the perspective. 

g. Default Nomenclature Search: Select the appropriate option from the list that determines the default 

nomenclature search. 

3. Click Apply. 

 

FIELD DUPLICATION 

Field Duplication preferences determine when fields can be duplicated during charge entry. 

Complete the following steps to set Field Duplication preferences: 

1. From the Preferences window, expand Charge Entry and select Field Duplication. 

2. Select the appropriate Field Duplication Mode:  

1. None: The system does not duplicate any charge event entry fields from one encounter to the next. 

2. Default: The system duplicates all standard charge event entry fields from one encounter to the next. 

3. Custom: The system duplicates all selected charge event entry fields from one encounter to the next. 

3. Use the arrow buttons to move the appropriate fields from the Available Fields list to the Selected Fields list. Use the arrow 

buttons underneath the Selected Fields list to reorder the fields as appropriate. 

4. Click Apply. 
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FIELD SKIPPING 

1. From the Preferences window, expand Charge Entry and select Field Duplication. 

2. Select the appropriate Field Duplication Mode: 

1. None. No fields are skipped. The cursor stops at every field when tabbing. 

2. Custom. The cursor stops at only the fields you select when tabbing. 

3. Use the arrow buttons to move the appropriate fields from the Available Fields list to the Selected Fields list. Use the arrow 

buttons underneath the Selected Fields list to reorder the fields as appropriate. 

4. Click Apply. 
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LINE ITEM OVERRIDE 

Release Considerations: The Line Item Override field is available with the Cerner Millennium 2015.01.19 Service Release. 

 

For the Line Item Override option to be displayed for a bill item in the Charge Entry perspective and the Charge Modify perspective, 

the Line Item Override flex field must be enabled in Charge Services Pricing Tool (CSPricingTool.exe). See the Design and Configure 

Charge Services Bill Item Flags Reference Page for more information. 

GENERAL 

In the General section, you can set your default quick search results, your default patient perspective, and your default non-patient 

perspective. 

 

QUICK SEARCH 

Complete the following steps to set your Quick Search preference: 

1. From the Preferences window, click General in the panel on the left. 

https://wiki.ucern.com/display/public/reference/Design+and+Configure+Charge+Services+Bill+Item+Flags
https://wiki.ucern.com/display/public/reference/Design+and+Configure+Charge+Services+Bill+Item+Flags
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2. Select the option to be used as the default in the Quick Search field. 

 

NOTE: IF YOU SELECT A DIFFERENT SEARCH TYPE VALUE FROM THE SEARCH BY LIST ON THE TOOLBAR, THAT 

SELECTION TAKES PRECEDENCE OVER YOUR SELECTION HERE. 

3. Enter your facility in the Facility box if the default facility is not correct. This facility will be displayed automatically in 

Revenue Cycle as the patient's facility. 

4. Select the country where your facility is located from the Country list. 

5. Select the phone format you want to use from the Phone Format list. An example of the selection you make is displayed to 

the right of the list. 

6. Click Apply. 

7. Click OK. 
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NON-PATIENT PERSPECTIVE 

 

 

Complete the following steps to set your Non-Patient Perspective preference from the Preferences window: 

1. Expand the General preferences on the left. These preferences determine what is displayed when you have not opened a 

particular patient record. 

2. Select Non-Patient Perspective. 

3. From the Default Non-Patient Perspective list, select the perspective you want displayed when you open Revenue Cycle. 

4. Move the non-patient perspectives you want to be available from the Available box to the Selected box. If you want all the 

perspectives, click the double arrow. Use the Up and Down arrows to place the perspectives in the order you want. Your 

selections are displayed as buttons on the left side of the framework in the order you designate. 

5. Click Apply. 

6. Click OK. 

PATIENT PERSPECTIVE 

 

 

Complete the following steps to set your Patient Perspective preference from the Preferences window: 

1. Select Patient Perspectives. Preference is set. These preferences determine what is displayed when you open a patient 

record. 

2. From the Default Patient Perspective list, select the perspective you want displayed when you open a patient record. 

NOTE: IF YOU SELECT A DIFFERENT PERSPECTIVE FROM THE SEARCH BY LIST ON THE TOOLBAR, THAT 

SELECTION TAKES PRECEDENCE OVER YOUR SELECTION HERE. 
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3. Move the patient perspectives you want to be available from the Available box to the Selected box. If you want all the 

perspectives, click the double arrow. Use the Up and Down arrows to place the perspectives in the order you want. Your 

selections are displayed as buttons at the top of the application in the order you designate. 

4. click Apply. 

5. Click OK if done setting preferences. Click Cancel to do nothing and close window. 

 

MY WORKFLOW 

The My Workflow perspective is an overview of work that needs to be done by you or any direct reports. You can use this 

perspective to view work items, reports, charge batches, and remittances that have been assigned to you and any of your direct 

reports. This perspective is non-patient specific.  

 

 

The My Workflow perspective includes the following views: 

• Personnel: The Personnel view displays users as defined in manager and supervisor relationships.  

• Reports: The Reports view displays all reports assigned to the user in context.  

• Charge Batches: The Charge Batches view displays charge batches for the user in context. Supervisors are able to view 

batches created by subordinates.  
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• Follow-Up: The Follow-Up view displays workflow items needing follow-up. Work items populate this view when released 

for follow up by the user or are forwarded to the user, by another, by use of an action code. A user can double-click an item 

from this view to put it into context or right-click to perform a task.  

• Workflow: The Workflow view within the My Workflow Perspective displays a personnel's assigned work. The detail view 

will display specific queue items where task can be performed directly on the queue item or the queue item can me set into 

context for follow-up.  

• Remittances: The Remittances view displays remittances created by the user in context. 

  

CHARGE BATCHES 

OVERVIEW 

The Charge Batches view displays manually entered charge batches. Supervisors can view batches created by subordinates. Double-

click a batch to open the Charge Batch Entry perspective with the batch in context.  

 

 

LIST ATTRIBUTES 

The following attributes are displayed in list view and the preview pane: 

• Batch Status 

• Batch Alias 

• Batch Date 

• Assigned To 

• Created By 

TASKS 
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The following tasks are available in the Charge Batches view: 

• Lock Charge Batch 

• Remove Charge Batch 

• Unlock Charge Batch 

FOLLOW-UP 

OVERVIEW 

The Follow-Up view displays time sensitive items. The items displayed are encounters previously identified as requiring follow up or 

items referred to you by other users. The Status column identifies the queue where the encounter resides. 

You can double-click an item from this view to put it into context for follow up. The only supported context for this view is 

Personnel. This view is available in the My Workflow perspective.  

 

 

LIST ATTRIBUTES 

The default sort is by the follow-up date and time in ascending order. The following attributes are displayed in list view and the 

preview pane: 

• Type: Entity type of the queue item. 

• Status: Status of the queue item. 

• Status Date: Date the item entered the queue with associated status. 

• Follow-Up Date: Date set for follow up. 

• Description: Varies depending on the accounts receivable (A/R) state. Client and General A/R states display the account 

name. Patient A/R states display the patient full name and encounter number. Transaction Batch states display the 

transaction batch description. 
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TASKS 

The following tasks are available from the Follow-Up view: 

• Apply Action Code 

• Apply Comment: The most recent comment added to a work item is also display in Discern Notify. 

• Manual Release 

• Reassign 

• Release with Follow-Up 

FILTERS 

The following filters and sort options are available in the Follow-Up view: 

• Sort  

o Follow-Up Date: By default, items are sorted by follow-up date in ascending order. You can sort by descending 

order when appropriate. 

o Status Date: You can sort by status date in ascending or descending order. 

• Filter  

o Status Date: You can filter by status date and date range. 

o Type: You can filter by types of referrals and released items. 

PERSONNEL 

OVERVIEW 

The Personnel view is in the My Workflow perspective. The only supported context for this view is Personnel. 

LIST ATTRIBUTES 

This view displays users as defined in manager and supervisor relationships. The default sort for is by the user who signed in, with 

any subordinates listed beneath for the next reporting level, in alphabetic order. The manager icon indicates whether the user 

has direct reports. Click the arrow for a list of subordinates.  
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Complete the following steps to view supervisor relationships:  

1. In the My Workflow perspective, select the Personnel view. 

2. Click the arrow next to the user's name. Subordinates for the supervisor are displayed.  

 

 

3. Double-click a subordinate's name. The perspective displays workflow information for that subordinate.  

 

 

REPORTS 
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OVERVIEW 

The Reports view displays all reports assigned to the user. Older instances are grouped beneath the most current version of the 

report. By default, the current instances of all assigned reports are displayed in alphabetic order.  

 

 

LIST ATTRIBUTES 

The following attributes are displayed in the Reports view: 

• Report Format Indicator: ASCII, Excel, and PDF 

• Description 

• Created 

• Purge Date 

TASKS 

The View Report task is available from the Reports view. 

WORKFLOW 

OVERVIEW 

The Workflow view within the My Workflow Perspective displays a personnel's assigned work. The view displays the name of each 

queue, count of encounters, dollar amount, and the percent of total count. Work queues are updated nightly. 

SUMMARY ATTRIBUTES 

The following attributes are displayed in the Summary view: 

• Status: Current status of account receivable (A/R). Status types include Ready to Bill, Past Due, Technical Denial, Past Due 

Self-Pay, Variance, Discharged, Not Ready to Bill, Good Standing Self-Pay , In House, and Generated. By default, all attribute 
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rows are collapsed under each status type. Double-click the status type to have all rows related to the status, with the detail 

attributes, displayed.  

o Type (Icon) 

• Count: Item count per workflow summary grouping. 

• Amount: Dollar amount associated to each workflow summary. 

• Percent of Total Amount: Dollar amount displayed as a percentage.  

 

 

DETAIL LIST ATTRIBUTES 

The Detail List is populated with items associated with the workflow summary selected. The default sort is status date in ascending 

order. The following attributes are displayed: 

• Status Date 

• Amount 

• Status 

• Description: Varies pending the A/R state. Client and General A/R states display the Account Name. Patient A/R states 

display Patient Full Name and Encounter Number. Transaction Batch states display the Transaction Batch Description. 

• Reason: For Work Items, the he Work Item alias is displayed. For other queues: It is the actual workflow reason. Currently 

there are only few queues using the Reason attribute. For example, the Demographics Modification queue shows a reason 

(Suspended charges, Lock error, and so on). Also, the Discharge Not Ready to Bill queue is using reason as well (not a 

default attribute). 

• Issue: For Work Items only. The Work Item name and the Work Item alias is displayed (not a default attribute). 

• Responsible: For Work Items only. The assigned Resolver for the Work Item is displayed (not a default attribute). 

• Responsible Type: For work items only. The Resolver Type will be displayed. When it is a department, Personnel are 

displayed since the work item is actually in someone's work queue (only displayed in the preview pane). 

• Reviewing: For work items only. The assigned Reviewer for the Work Item is displayed (not a default attribute). 

• Related Encounter Financial Number (FIN): When a billing combine work item is identified, the Related FIN field is 

populated with the related encounter’s financial number. When a Billing Combine Work Item in the assessment state is 

approved, the corresponding Work Item also displays the related encounter’s financial number. When a Billing Combine 

Work Item in the assessment state is denied, the corresponding work item also displays the related encounter’s financial 

number. 
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NOTE: THE RELATED ENCOUNTER’S FIN IS DISPLAYED  IN THE WORK ITEM DETAILS (PATIENT ACCOUNT PERSPECTIVE 

AND MY WORKFLOW PERSPECTIVE) FOR BILLING COMBINE WORK ITEMS. THE RELATED FIN FIELD IS DISPLAYED IN 

DISCERN NOTIFY FOR BILLING COMBINE WORK ITEMS. 

 

 
 

The preview pane is accessed by clicking the arrows at the bottom of the view window. The preview pane displays all available 

attributes. 

TASKS 

The following tasks are available in the Workflow Detail view: 

• Apply Action Code 

• Apply Comment: The most recent comment applied to a work item will also display in Discern Notify. 

• Manual Release 

• Open FirstNet: The system will launch the application in the context of the encounter associated with the work item. 

• Open PowerChart: The system will launch the application in the context of the encounter associated with the work item. 

• Open SurgiNet: The system will launch the application in the context of the encounter associated with the work item. 

• Reassign 

• Registration Conversation: The system will launch the application in the context of the encounter associated with the work 

item. The task menu may display as many as two conversations. 

• Release with Follow-Up 

• Identify Work Item 

The following tasks are available in the Workflow view at the summary level: 

• Redistribute 

• Redistribute All 

INSURANCE BALANCE 

• Sort: Status Date, Begin Date and Amount (Ascending and Descending) 
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• Health Plan 

• Facility 

• Encounter Type 

• Financial Class 

• Status 

• Status Date 

• Bill Type 

• Attending Provider 

• Reason: The list of workflow reasons will be insurance workflow reasons for the list of balances that currently reside in the 

users work queues. If greater than 50 items exist when filtering by workflow reason, only 50 items will be displayed. 

• Encounter Date 

• Patient Last Name 

SELF-PAY BALANCE 

• Sort: Status Date and Amount (Ascending and Descending) 

• Health Plan: The system allows a user to filter by health plan within a Self-Pay work queue so they can view items based 

upon their assigned Self-Pay health plan. The list of health plans will be Self-Pay health plans for the list of encounters that 

currently reside in the users Self-Pay work queues. The filter can be applied in conjunction with any other list of filters in the 

Self-Pay queue view. If greater than 50 items exist when filtering by health plan, only 50 items will be displayed. 

• Facility 

• Encounter Type 

• Primary Financial Class 

• Status 

• Status Date 

• Statement Cycle 

• Attending Provider 

• Reason: The list of workflow reasons will be Self-Pay workflow reasons for the list of Self-Pay balances that currently reside 

in the users work queues. If greater than 50 items exist when filtering by workflow reason, only 50 items will be displayed. 

• Encounter Date 

• Patient Last Name 

ENCOUNTER 

• Sort: Status Date and Amount (Ascending and Descending) 

• Facility 

• Encounter Type 

• Financial Class 

• Status 

• Status Date 

• Attending Provider 

• Reason: The list of workflow reasons will be encounter workflow reasons for the list of encounters that currently reside in 

the users work queues. If greater than 50 items exist when filtering by workflow reason, only 50 items will be displayed.  

o Amount Range 

o Length of Stay: Provides the ability to filter the "Ready to Bill encounter queue to identify encounters base on their 

length stay. Length of stay is determined as the differences between the discharge date and the admit date. When 

no admit date, length of stay is determined as the differences between the discharge date and the registration 

date. Numbers can be manually entered. 
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• Encounter Date 

• Patient Last Name 

CLAIM 

• Sort: Status Date and Amount (Ascending and Descending) 

• Health Plan 

• Facility 

• Status Date 

• Financial Class 

• Status 

• Payment Amount 

• Bill Type 

• Encounter Type 

• Attending Provider 

• Encounter Date 

• Claim Sequence 

• Patient Last Name 

NOTE: YOU CAN FILTER EDIT FAILURE WORKFLOW QUEUE ITEMS BY CATEGORY GROUP, CATEGORY, SEVERITY, AND 

EDIT FAILURE ALIAS.  

THE UP AND DOWN ARROWS IN THE FINANCIAL PERSPECTIVES HONOR THE WORKFLOW SORT AND FILTER CRITERIA, 

ALLOWING YOU TO MOVE THROUGH YOUR ASSIGNED WORK WITHOUT HAVING TO RETURN TO THE WORKFLOW 

VIEW. 

 

PATIENT (PERSON) SEARCH 

SEARCH 

One of the critical pieces to account review is knowing how to find the right patient and the right encounter to look at. There are 

multiple ways to start a patient search and select an encounter, and all methods result in the same outcome. 

To search for a patient and select an encounter, use any of the following starting points: 

• Quick Search 

• Standard Person Search 

• Open Person Record from the File Menu 

  

https://wiki.ucern.com/display/public/rcaHP/Performing+a+Quick+Search+Using+Revenue+Cycle
https://wiki.ucern.com/display/public/rcaHP/Performing+a+Standard+Person+Search+Using+Revenue+Cycle
https://wiki.ucern.com/display/public/rcaHP/Open+Patient+Record+from+the+File+Menu
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QUICK SEARCH AND DESTINATION PERSPECTIVE  

 

 

STANDARD PERSON SEARCH 
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OPEN PATIENT RECORD FROM THE FILE MENU 

You can open patient records by selecting Open Patient Record from the File menu. The open patient record launches the standard 

person search, explained in the previous section.  

 

 

 

GUARANTOR SEARCH 

The guarantor search is accessed by selecting it from Quick Search or clicking the Guarantor tab in the person search. In Guarantor 

Search, you can search by the following options: Name, Social Security Number (SSN), and Date of Birth. Also available to use as 

filters are: Claim, CMRN, Fin Nbr, Gender, MRN, and Statement number.  

 

Quick Search  

 
 

Guarantor Tab in the Person Search  
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The bottom section of the screen displays the clinical encounters for each patient. If you are accessing certain functionality in the 

system driven by encounter, selecting an encounter takes you directly to that encounter. For example, the Encounter perspective 

and Patient Account perspective use the encounter number selected and if you selected an encounter from the search, the 

perspective displays the encounter information when opened. If you are accessing Registration or Scheduling, selecting the 

encounter has no impact. 

Complete the following steps to perform a guarantor search: 

1. Click Search  icon on the toolbar. The Person Search window is displayed. 

2. Click the Guarantor tab.  
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3. Enter the search criteria and click Search. The search results are displayed.  

o You can search by the following options: Name, Social Security Number (SSN), and Date of Birth. 

4. Expand the Guarantor to view all persons who the guarantor has a person/guarantor relationship with.  

 

 

5. Select a guarantor and encounter and click Select. 

NOTE: CLICK PREVIEW  AT THE TOP TO VIEW THE GUARANTOR'S NAME, DATE OF BIRTH, GENDER, SSN, MRN, 

AND CONTACT INFORMATION. 
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SETTING SEARCH PREFE RENCES 

Preferences are set separately for the Person and Guarantor tabs. The Search Preferences dialog box is displayed based in the tab 

displayed when Preferences is selected.  

 

 Person tab selected 

 

 

Guarantor tab selected  

 

NOTE: TASK ACCESS MUST BE GRANTED FOR TASK 130109 TO MODIFY SEARCH PREFERENCES.  

TO SET SYSTEM WIDE SEARCH PREFERENCES, CLICK THE CONFIGURATION LINK. 

ADDING FILTER GROUPS 

Filter Groups provide the ability to configure Person Search to navigate you through predefined search criteria and reduce the 

chance of a duplicate person being added to the database.  

 

Complete the following steps to add a new filter group: 

1. Click Preferences in the Person Search dialog box. 
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2. Select Enable Preferences. The Add Filter Group button is enabled.  

 
  

3. Click . The Add Filter Group window is displayed.  

4. Enter a Filter Group Name. 

5. Move the desired Filters from Available to the Selected window and place in order by clicking the arrows. 
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6. Select a filter and the Required box if any filter is required.  
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7. Define the sequence order of the Filter Groups flow.  

 
  

8. Click Restore Defaults to delete all preference level filter groups. 

9. Click OK to save the new Filter Group. 
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USING THE FILTER GROUPS 

Complete the following steps to use the available Filter Groups: 

1. Enter the required search fields for the Filter Group.  

 
  

2. Click Search. 

3. If no person is found or you do not have the available patient information for that Filter Group, click Next to advance to the 

next set of search filters.  
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4. Repeat the search until all filter groups are executed or the person is found in the database. 

MODIFYING A FILTER GROUP 

Complete the following steps to open the Modify Filter Group window and modify preference level filter groups: 

1. Click . The Modify Filter Group window is displayed.  

 
  

2. Make necessary modifications. 

3. Click OK to save your changes. 

REMOVING A FILTER GROUP 

Complete the following steps to remove a Filter Group: 

1. Select the filter group to be removed. 
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2. Click . A message is displayed asking you to confirm the removal of the filter group.  
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3. Click Yes. The Filter Group is removed.  
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SETTING PERSON RESULTS 

Complete the following steps to set preferences for person results: 

1. Click the Person Results tab. The person results criteria are displayed.  

 
  

2. Click the arrows to move the items you need displayed in the Person Results from Available to Selected. 

3. Click the double arrows to move all items from one column to the other. 

4. Click the arrows at the bottom of Selected Results to change the order in which the results are displayed. 

5. If appropriate, give the item a new label in New Label on the right. 
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6. Click OK to save your preferences.  
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SETTING ENCOUNTER RE SULTS 

Complete the following steps to set preferences for encounter results: 

1. Click the Encounter Results tab. The encounter results criteria are displayed. 

2. Click the arrows to move the items you need displayed in the Person Results from Available to Selected. 

3. Click the double arrows to move all items from one column to the other. 

4. Click the arrows at the bottom of Selected Results to change the order in which the results are displayed 

5. If appropriate, give the item a new label in New Label on the right. 

6. Click OK to save your preferences.  
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LIMITING ENCOUNTER RESULTS 

Complete the following steps to set preferences for limiting encounter results: 

1. Click the Limit Encounter Results tab. The limit encounter results criteria are displayed. 

2. Select or deselect to limit the encounter results. If you select to limit results, select the limit in Maximum Number of 

Encounters. 

3. To limit encounter results by types, select Limit Encounter Results By Types. 

4. Click the arrows to move encounter types from Available to Selected. 

5. Click the double arrows to move all items from one column to the other.  

 
 

SETTING THE GENERAL SETTINGS 

Select or deselect to Assume Wildcards, to use Phonetic Search, or to use Any Name Search. 

• Assume Wildcards allows a partial name search without having to enter an asterisk. 

• Phonetic Search returns a name that sounds like the name entered in the search, such as Smyth and Smith. 

• Any Name Search allows the system to search for alternate names such as maiden or previous name. 

• EMPI Search Services option allows you to configure a match threshold called EMPI Search Weight Threshold. The default 

threshold is 75 on a scale of 100. Any name match with a weight threshold greater than or equal to 75, in this example, 
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would display in the search results. A match percentage then displays in the Match Weight column. The Match Weight 

column is available on the Person and Guarantor search. 

In order to perform the most robust search and minimize the chance of creating duplicate persons, select Assume Wildcards, 

Phonetic Search and Any Name Search search preferences.  

 

 

EXTERNAL PROVIDER SE ARCH 

In addition to the Cerner Millennium provider search, an external provider search is available for the Referring Provider check box. 

This searches the NPI National Registry (NPPES) database and returns the following data for a provider:  

• Name and credentials 

• Aliases 

• Address 

• Specialty 

Once a search is performed and a provider selected, the provider is added to the Cerner Millennium database and is found in future 

Referring Provider Searches.  
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OVERVIEW OF THE PATIENT ACCOUNT PERSPECTIVE 

 

PATIENT ACCOUNT CONTEXTS   

Context is a key concept when working in a Patient Centric perspective. Understanding and managing the context of the Patient 

Account perspective is key to viewing, understanding, and working through encounters efficiently.  

 

ENCOUNTER IN CONTEXT 

After selecting a person and opening to the patient account perspective from the search, the patient’s account is displayed. 

Information is displayed for the entity in context. By default, the system puts the encounter into context. Parent information is 

displayed in the top row, with the detail information in the upper right corner. Immediate children are displayed in the bottom row. 

Views not displayed, but available for the perspective, are also put into context. 

You can view more information by double-clicking a line item in one of the views. Using the navigation bar, you can drill out to 

higher levels. 

NOTE: ACCESSING A PATIENT ACCOUNT WITH NO FINANCIAL ACTIVITY WILL RESULT IN A BLANK PERSPECTIVE. 
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1. Perspective Name 

2. Search 

3. Patient Centric Perspectives 

4. Open View 

5. Patient Record 

6. Demographic Banner 

7. Navigation Bar 

8. Non-Patient Centric Perspectives 

9. Views: The top row displays the Patient Account in the left and Encounters in the right. The bottom row displays the 

Balances as active, followed by Claims, Statements, Charges, Insurance Transactions, Self-Pay Transactions, and 

Comments.  

 

NOTE: REFER TO NAVIGATION BAR BELOW 
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This navigation bar is located below the Demographic Banner when you access a Patient Account.  

BUTTON DESCRIPTION 

 
Allows you to navigate forward and backward through your recent 
perspectives 

 
Lists your recent perspectives. You can select a perspective to 
navigate to from this list 

 
Lists where you have navigated in Patient Account. The current 
context is the last one in is the last one in the list. Clicking on the last 
item in the list refreshes the application to display the more recent 
saved content. Click on any of the other items in the navigation bar to 
open that perspective.  

Note: Content that is saved automatically will not change when you 
refresh the application 
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PATIENT ACCOUNT IN CONTEXT 

When the patient account is in context, the top row displays the Patient Account view in the left and the Balance Summary in the 

right. The bottom row displays the Encounters view as active followed by the Guarantor, Balances, Claims, Statements, Charges, 

Insurance Transactions, Self-Pay Transactions, and Comments. 
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CHARGE IN CONTEXT 

When a charge is in context, the top row displays the Patient Account and Encounters views in the left and Charges in the right. The 

bottom row displays the Insurance Transactions view as active, followed by Claims and Comments. 
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CLAIM IN CONTEXT 

When a claim is in context, the top row displays the Encounters and Patient Account views in the left and Claims and Balances in 

the right. The bottom row displays the Insurance Transactions view as active, followed by Related Balances, Related Claims, 

Charges and Comments.  

 
 

  



58 
 

INSURANCE BALANCE IN CONTEXT 

When an insurance balance is in context, the top row displays the Encounters and Patient Account views in the left and Balances in 

the right. The bottom row displays the Insurance Transactions view as active, along with Claims, Related Balances, Charges and 

Comments. 
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INSURANCE TRANSACTION – CLAIM IN CONTEXT 

For Insurance Transaction-Line Item, the top row displays the Encounters and Patient Account views in the left and Insurance 

Transactions, Balances, Charges, and Claims views in the right. The bottom row displays the Comments view followed by Related 

Balances.  
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SELF-PAY BALANCE IN CONTEXT 

The top row displays the Encounters and Patient Account views in the left and Balances in the right. The bottom row displays the 

Statements view as active, followed by Self-Pay Transactions, Charges, and Comments. 
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SELF-PAY TRANSACTION IN CONTEXT 

When a Self-Pay transaction is in context, the top row displays the Encounters and Patient Account views in the left and Self-Pay 

Transactions and Balances in the right. The bottom row displays the Statements view as active, followed by Comments.  
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SELF-PAY TRANSACTIONS – STATEMENT IN CONTEXT 

When a statement is in context then you put an associated transaction into context, the top row displays the Encounters and 

Patient Account views in the left and Self-Pay  Transactions, Balances, and Statements in the right. The bottom row displays the 

Charges view as active, followed by Comments.  
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STATEMENT IN CONTEXT 

when a statement is in context, the top row displays the Patient Account and Encounters views in the left and the Statement view 

in the right. The bottom row displays the Self-Pay Transactions view as active, followed by Comments. 

 
 

NOTE: CONSOLIDATED STATEMENT IN CONTEXT – WHEN A CONSOLIDATED STATEMENT IS CONTEXT, THE TOP ROW 

DISPLAYS THE PATIENT ACCOUNT VIEW IN THE LEFT AND STATEMENTS IN THE RIGHT. THE BOTTOM ROW DISPLAYS 

THE ENCOUNTERS VIEW AS ACTIVE, FOLLOWED BY SELF-PAY TRANSACTIONS, AND COMMENTS. 
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PATIENT ACCOUNTING WORKFLOW NAVIGATION BAR 

The following icons appear only when you navigate to Patient Account from My Workflow:  

 
You can hover over this icon to see information from My 
Workflow, such as the type of the work item and status.  

 

Displays the status of the workflow item. You can hover over 
the status to see information from My Workflow, such as the 
type of the work item and status. Click on the status to take 
you back to My Workflow.  

 

Allows you to move to your previous and next items in your 
workflow.  

 
Allows you to return to the initial perspective you entered from 
your workflow. Hover over it to see more information.  

 
Allows you to apply an action code.  

 
Allows you to perform a manual release.  

  
Allows you to reassign the workflow item.  

 
Allows you to release an item from your workflow and add a 
follow-up to it.  

 
Hover to discover – hovering over the info bubble will display 
additional information 
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PATIENT ACCOUNT VIEWS 

Patient Account Views are key component of patient accounting. 

• Balances 

• Claims 

• Statement 

• Charges 

• Insurance Transactions 

• Self-Pay Transactions 

• Billing Holds 

• Related Encounters 

• Timeline 

• Workflow 

Individual Views can be closed by pressing the X on the tab. Views can be opened from the View menu or from the Open View icon 

 

 

 

BALANCES 

This tab displays the balances associated to the encounter, where any open balances reside whether with the insurance benefit 

order which can be the Primary insurance, Secondary, Tertiary, etc. or in Self-pay. Right click on the benefit order row to view the 

available options.  

Common Selections: 

• Complete – choosing this option will complete the benefit order and roll the balance to the next benefit order 

• Set as Ready to Bill – this option changes the benefit order from generated to ready to bill and a claim will generate once 

more 

• Generate Claim – select this option to generate a claim. This option is available if a claim isn’t already generated in the 

Claims tab and dithered if otherwise 

 



66 
 

 

CLAIMS 

This tab displays the claims associated to the encounter. Claims can be in various states: 

• Pending – Edit failures exist and review is needed 

• Ready to submit – Claim is ready to be processed by nightly ops jobs and sent to the clearinghouse  

• Submitted – Claim has been submitted to the clearinghouse 

• Transmitted – Confirmation has been received that the clearinghouse received the claim 
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Right click on a claim row to open the available options.  

Common Selections: 

• Open Claim – this will open the Bill Record Browser widow and display the claim 

• Cancel Claim – this will cancel the claim and cannot be undone 

• Deny Claim – this option is available when a technical denial has been received from the payer 

• Replace Claim – system criteria must be met for this option to be available  

• Void Claim – system criteria must be met for this option to be available  

STATEMENTS 

This tab displays the statements associated to the encounter.  

Common Selections: 

• Open Statement – this option will open the Bill Record Browser window and display a preview of the statement or display 

the actual statement if the statement Vendor has returned the statement confirmation 

 

 

CHARGES 

This tab displays the Charges associated to the encounter. Charges can be in a varies of statuses: 

• Posted  

• Credited  

• Adjusted 

• Written Off 

Use the Filter to select which charges to display. Right click the charge to view the available options. 

Common Selections: 

• Credit – select this option when a charge needs to be credited  

• Write Off – select this option when you do not intend to bill for that specific charge or charges. Note: the 

charge will display as an adjustment 

• Modify Charge – select option to change or correct a charge 

• Apply Adjustment – selection option to apply an adjustment at the charge level 

NOTE: YOU CANNOT UNDO A CREDIT OR WRITE OFF IN THE PATIENT ACCOUNT PERSPECTIVE. YOU WILL NEED TO GO 

TO CHARGE VIEWER TO MODIFY. 
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INSURANCE TRANSACTIONS 

This tab displays the Insurance Transactions associated to the encounter. Right click on a transaction row to view the options 

available.  

NOTE: RIGHT-CLICK OPTIONS ARE DETERMINED BY POSITION ACCESS AND RIGHTS THAT ARE DETERMINED USERS 

SHOULD HAVE TO PERFORM THEIR ROLE WITHIN THE APPLICATION. 

 

SELF PAY TRANSACTIONS 

This tab displays the Self Pay Transactions associated to the encounter. Right click on a transaction row to view the options available.  

NOTE: RIGHT-CLICK OPTIONS ARE DETERMINED BY POSITION ACCESS AND RIGHTS THAT ARE DETERMINED USERS 

SHOULD HAVE TO PERFORM THEIR ROLE WITHIN THE APPLICATION. 
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TIMELINE 

The Timeline view will display activity associated to the encounter such as actions codes applied, comments added by users, and 

third party notes. 

 

BILLING HOLDS 

The Billing Holds view displays any holds applied to the encounter. If this view is empty, then there aren’t any holds applied. Right 

click the row to view the available options. 

The Events column will display what types of billing the hold will prevent. Hold are configured with different types of hold, for 

example, some only holding Self-Pay billing and not claims.  

Common Selection: 

• Remove Billing Hold – this action will remove the hold 

NOTE: ONCE A HOLD IS REMOVED THE IT CANNOT BE UNDONE. IF A CAN BE REAPPLIED USING THE APPLY BILLING 

HOLD FEATURE. 

 

RELATED ENCOUNTERS 

The Related Encounters view displays other encounters related to the current encounter in view. In this tab the current encounter is 

denoted by a green check mark. The encounters that display are driven by a shared guarantor. Right click the row to view the 

available options. 

 

WORKFLOW 
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The Workflow tab will display the current status of the encounter and whom it’s assigned to. Right click the row to view the available 

options. 

Common Selections: 

• Apply Action Code – applying an action code will release a work item 

• Release with Follow-up – this option will release the encounter from the workflow for the selected timeframe 
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FREQUENTLY USED TASKS 

IDENTIFYING A WORK ITEM 

You can use the Identify Work Item task to create a work item for an encounter, claim, or a specific balance. 

Complete the following steps to use the Identify Work Item Task: 

1. In the Encounters tab of the Encounters view, open the task menu and select Identify Work Item. The Identify a Work Item 

dialog box is displayed. 

 
2. Complete the information to set the criteria. 

3. Click Add. The task now is displayed.  
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4. Click OK.   

  

NOTE: IF THE ISSUE IS DEFINED AS NEEDING TO BE REVIEWED AFTER IT HAS BEEN RESOLVED, THE PERSON WHO 

IDENTIFIED THE ISSUE IS THE REVIEWER. 

RESOLVING A WORK ITEM 

Once a work item is created, either manually or through a system event, it must be resolved. There are two mechanisms for 

resolving a Work Item, from Revenue Cycle or Discern Notification. 

NOTE: EVERY WORK ITEM IS CREATED AS PART OF A SPECIFIC WORKFLOW. THE STEPS OUTLINED ON THIS PAGE ONLY 

ILLUSTRATE THE STEPS TAKEN TO RESOLVE THE WORK ITEM ITSELF AND NOT FOR A SPECIFIC WORKFLOW. A WORK 

ITEM SHOULD ONLY BE RESOLVED ONCE ALL ISSUES RELATED TO THE SPECIFIC WORKFLOW ITSELF HAVE BEEN 

RESOLVED. 

RESOLVING FROM REVENUE CYCLE 

Work items are displayed in Revenue Cycle similarly to state-based or exception queue items. 

Complete the following steps to resolve a work item in Revenue Cycle:  

1. Double-click on the queue.  
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2. Select a work item and expand the work item details.  

 
 

3. Review the comments and take the appropriate action to correct the identified issue.  

4. Once the issue has been resolved, right click on the Work Item from the queue and select Apply Action Code  

5. Select the Action Code that will resolve the Work Item, and enter any appropriate comments.  

 

 

NOTE: WORK ITEMS ARE CONFIGURED TO ACCEPT SPECIFIC ACTION CODES FOR RESOLUTION. IF THE ACTION 

CODE SELECTED WAS NOT IDENTIFIED AS ABLE TO RESOLVE THE WORK ITEM, THE WORK ITEM WILL NOT BE 

RESOLVED. YOU MUST SELECT THE CORRECT ACTION CODE TO RESOLVE THE ITEM. 
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6. Once the Action Code is applied, the work item is resolved and is removed from the queue.  

 

 

RESOLVING FROM DISCERN NOTIFICATION 

For end-users that do not access Revenue Cycle, work items may still be assigned to them and resolved through Discern Notification. 

The Work Item is displayed as an individual message in the application with details similar to the view in Revenue Cycle. From 

Discern Notification, you can access the following applications:  

• PowerChart 

• SurgiNet 

• FirstNet 

Selecting any of these options from the Task menu opens the selected application directly into the patient record for the identified 

Work Item, allowing any corrections to be made. Once the appropriate action has been taken, the Work Item may be resolved. 

Complete the following steps to resolve a work item in Discern Notification: 
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1. Select a work item. The Work Item details are displayed.  

 
 

2. Review the work item, and from the Task menu on the right-hand side of the dialog box, access the appropriate application.  

3. Once all issues have been corrected, enter any appropriate comments and click the Resolve link to apply the action code. 

The work item is resolved. 
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ACCESSING REGISTRATION CONVERSATIONS 

ACCESSING REGISTRATION CONVERSATIONS FROM PATIENT ACCOUNTING 

You can access to registration conversation through Revenue Cycle. This is helpful if a patient’s registration needs to be modified 

throughout the life cycle of a patient.  

A patient’s registration information can be updated at the encounter level or patient level. For patient accounting purposes, we 

recommend updating at the encounter level. 

 

UPDATING INSURANCE INFORMATION AT THE ENCOUNTER LEVEL 

1. Access the Encounters perspective  

2. Go to Encounter Details tab 

3. From the conversation drop down select Pt Acct Modify Encounter 

4. Click on the green pencil icon to modify 

5. Click on the Insurance tab 

 

6. Select the Health Plan that needs to be modified – options will become available such as  

• Modify 

• Remove  

• Sequence Insurances (if there are more than one) 

• Select Profile 

7. Click on the Save icon when complete or the Cancel icon to exit without modifying  

 

 

 

 

ACCESSING REGISTRATION FROM CERNER PRACTICE MANAGEMENT 

Access to the CPM registration conversation is available through Revenue Cycle. This can be used if the patient’s registration needs 

to be changed throughout the life cycle of the patient. Be aware that changes here will impact all encounters. 
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Complete the following steps to access the CPM registration conversation: 

1. Click the Registration button . The Registration perspective opens with the patients information displayed. 

2. Click the modify button to modify. 

3. Select the appropriate tab.  

 
 

4. Update information. 

5. Click Save to save changes. 

ACCOUNT LEVEL UPDATE  

Insurance plans can be changed at one of two levels, the account level and the encounter level. A change at the account level is an 

overall change to the person that will correspond with the Begin Date that is entered. The change will apply to all encounters 

created after the time of update. The change is made by using the Registration button in the patient perspective. 

Complete the following steps to access the CPM registration: 

1. Click the Registration button . The Registration perspective opens with the patients information 

displayed. 

2. Click the modify button to modify. 

3. Select the Insurance tab to view the current insurances.  

 

 

4. To remove an insurance, select the insurance and click Remove Insurance button. 
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5. To enter a Termination End Date and move the insurance to the Historical section of the insurances, highlight the insurance 

and select the Modify Insurance icon.  

 
 

6. To add a new insurance, click the Add Insurance button.  

 
 

7. Search for insurance and complete the required boxes and any additional boxes if information is available (i.e. Group 

Number, Insured Name on Card).  
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8. Click OK to save. The new insurance displays as an Unassociated insurance.  

 
 

o Unassociated: Insurance has not been added to an Insurance Profile. 

o Associated: Insurance has been added to an Insurance Profile. 

o Historical: Insurance that was previously effective coverage for a patient (associated or unassociated), but is no 

longer active. 
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9. Click Manage Profiles to add the insurance to the appropriate Profile description.  
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ENCOUNTER LEVEL UPDATE 

A change made at the encounter level will apply only to that encounter. Encounter level changes will not change the insurance that 

is on the account level, and only applies to that specific encounter. For example, a patient’s personal insurance was used for an 

encounter, but a third-party insurance (No Fault, Work Comp, etc.) is responsible for the encounter. The change is made by using the 

Encounters perspective button located at the top of the Patient Accounting perspective. 

Complete the following steps to update insurance at the encounter level: 

1. Click the Encounters perspective button. The Encounters perspective opens. 

2. Select the Encounters tab.  

 
  

3. Double-click the encounter to be edited. The Encounters tab is displayed with the Details tab displaying encounter details 

for the encounter. 

4. Click the modify button . 

5. Click the Insurance tab. 

6. The steps to Add Insurance, Modify Insurance, and Remove Insurance are described in the Account Level above. Refer to 

those steps to execute any of these functions. 

7. Click Save . Updates are saved. 
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USING WORK QUEUES  

INSURANCE WORK QUEUE STATES 

State-based queues allow you to organize workflow items to follow the natural progression of a patient's financial encounter 

through the Patient Accounting system. Each balance is included in only one state-based queue at a time, in an effort to ensure that 

every item in the Patient Accounting system is accounted for 

NOTE: ITEMS DISPLAYED IN STATE-BASED QUEUES MAY ALSO BE DISPLAYED IN AN EXCEPTION QUEUE. AN 

EXCEPTION QUEUE DISPLAYS ITEMS THAT QUALIFY FOR SCENARIOS OUTSIDE OF THE TYPICAL PROGRESSION OF 

PATIENT ACCOUNTING. 

STATE-BASED QUEUES 

PREREGISTRATION 

1. Preregistration charges are charges generated for an inpatient or outpatient encounter, but the patient has not yet been 

presented for care. 

2. These charges are removed from the queue if one of the following happens: 

3. The charge is resolved. 

4. The encounter status is modified to Active. 

5. The encounter type is modified. 

IN-HOUSE 

1. Encounters in this queue are for patients are qualified as In-House. This is based on billing entity-level defined rules. 

2. Any encounter is removed from the queue when an associated patient is discharged. Recurring encounters can also be 

removed when the patient the billing cycle ends. Observation charges can also be removed when the encounter type is 

modified. 

3. Discharged, Not Ready To Bill 

4. Patients in a Discharged, Not Ready To Bill status have been discharged but have encounter-level holds applied. 

5. Patients are removed from the queue by a Cerner Millennium Operations job when holds are removed. 

READY TO BILL 

1. Claims in this queue are ready to be claim generated. 

2. Claims are removed from the queue by a Cerner Millennium Operations job when they no longer meet the qualifications. 

EDIT FAILURE 

1. Claims in this queue are generated but contain one or more validation errors. 

2. Claims are removed from the queue by a Cerner Millennium Operations job when all validation errors are corrected. 

PENDING MANUAL REVIEW 

1. Claims in this queue qualify for manual review based on client-defined business rules. 

2. Claims are removed from the queue by a Cerner Millennium Operations job when they no longer meet the qualifications. 

PENDING EDIT CLAIM 
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1. Claims in this queue are submitted but not transmitted. 

2. Claims are removed from the queue by a Cerner Millennium Operations job when they no longer meet the qualifications. 

PENDING REIMBURSEMENT 

1. Claims in this queue are submitted or transmitted and not past due. 

2. Claims are removed from the queue by a Cerner Millennium Operations job when they no longer meet the qualifications. 

 

PAST DUE 

1. Claims in this queue are submitted and past due. Client defined business rule criteria is met for number of days since claims 

transmission has passed and no payment has been received. Usually this is around 30 days. When transmission date is 

received from the clearinghouse, the transmission date is updated, and new date is used. 

2. Claims are removed from the queue by a Cerner Millennium Operations job when they no longer meet the qualifications. 

AT RISK CLAIM 

1. Claims in this queue have met a defined number of days since they were transmitted and have not received a payment. 

2. Claims are removed from the queue by a Cerner Millennium Operations job when they no longer meet the qualifications. 

TECHNICAL DENIAL 

1. Claims in this queue have received a technical denial. 

2. Claims are removed from the queue by a Cerner Millennium Operations job when the denial is resolved or a payment is 

received the amount rolls to a benefit order. 

EXPLANATION OF BENEFIT (EOB) VARIANCE 

1. Claims in this queue are complete but there is still a balance for a benefit order. 

2. Claims are removed from the queue by a Cerner Millennium Operations job when the balance is paid or the amount is 

moved to another benefit order. 

CREDIT BALANCE 

1. Claims in this queue received a payment exceeding the balance. 

posted to claim exceeds the balance of the claim. 

2. Claims are removed from the queue by a Cerner Millennium Operations job when they no longer meet the qualifications.  

EXCEPTION WORK QUEUE  STATES 

PENDING LATE CHARGE REVIEW 

1. Pending late charges are on submitted claims and that have not met the set number of days for evaluation. 

2. These charges are removed from the queue by a Cerner Millennium Operations Job when they qualify as a late charge. 
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LATE CHARGES 

1. Late charges have passed the set number of days for evaluation. 

2. These charges are removed from the queue by manual review or generating a claim. 
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CONTACT VARIANCE 

1. Contract variance claims qualify for client-defined rules when payments are over or under the balance. This only applies to 

clients with Contract Management services. 

2. These charges are removed from the queue by a Cerner Millennium Operations Job, or manual review. 

REJECTED 837 

1. Claims in this queue are in a Rejected status due to a 997. 

2. These charges are removed from the queue by a Cerner Millennium Operations Job or manual review. 

DEMOGRAPHIC MODIFICATIONS 

1. Demographic Modifications are encounters that require health plan modifications or combined encounters that require 

manual review.  

2. These encounters are removed when you apply an action code or manually remove holds. 

ENCOUNTER COMBINES 

1. Combined encounters are more than one encounter associated with each other through performing an encounter combine. 

2. These encounters are removed from the queue when their holds are removed. 

CODING UPDATES 

1. Claims in this queue have updating coding in a Final status. 

2. These claims are removed from the queue by manual review. 

COLLECTION PREVIEW 

1. These are encounters that are qualified to be sent third-party collection agency based on user-defined business rules.  

2. These claims are removed from the queue by manual review. 

REFERRAL 

1. These are encounters, claims, or statements referred to the user by another user for follow-up assistance. 

2. These claims are removed from the queue by manual review. 

DIAGNOSIS ASSOCIATION REVIEW 

1. These are encounters that were coded in Chart Coding but need coding associated at the Charge level. 

2. These charges are removed from the queue by a Cerner Millennium Operations Job. 

ERROR TRANSACTION BATCHES 

1. Transaction batches in this queue contain errors. 

2. These batches are removed from the queue by manual review. 
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TRANSACTION BATCH APPROVAL 

1. Transaction batches in this queue have been submitted by a user but the batch contains transactions over the dollar 

amount defined by the client in the Sub Type Personnel Security Tool. 

2. These batches are removed by manager approval. 

Out of Balance 

1. Transaction batches in this queue have a zero balance. 

2. These batches are removed from the queue by manual review.  

WORKING THE INSURANCE EDIT FAILURE QUEUE  

The Edit Failure queue contains claims that have been generated but are not yet submitted and have a status of Error – Correction 

Required. The claims will remain in the queue until corrected. 

Complete the following steps to correct claims that are in the Edit Failure queue: 

1. In the My Workflow perspective, select the Workflow view and double-click the Claim Edit Failure queue. Queue items and 

available filters are displayed.  
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2. Double-click a queue item. The patient account is displayed with the balance in context and the workflow toolbar displayed.  
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3. Select the Claims view. Claim information is displayed.  

 

 
4. Select a claim and right-click. The task menu is displayed.  

 

 

 
5. Select Open Claim. Claim is displayed. 
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6. Click Validate. Validation errors are displayed.  

 

 

Validation errors displayed  

 

 

7. Review Validation Edit. Double-click the error to have the location of the error on the claim displayed for further 

investigation.  

NOTE: THE EDIT TAB IS WHERE SPECIFIC INFORMATION POPULATED ON THE CLAIM IS VIEWABLE, AS WELL AS ANY 

ADDITIONAL INFORMATION THAT IS INCLUDED IN THE 837 INTERFACE FILE, IF THE CLAIM IS BEING SENT 

ELECTRONICALLY TO A SCRUBBER OR PAYER. THIS IS ALSO WHERE THE ELECTRONIC WHITE-OUT FUNCTION OF THE 

SYSTEM IS PERFORMED. IF THERE IS A FIELD ON THE CLAIM THAT NEEDS TO BE CHANGED, IT CAN BE DONE SO HERE. 

ANYTHING CHANGED ON THIS TAB, BEFORE A CLAIM IS PRINTED OR SUBMITTED, WILL BE INCLUDED ON THE CLAIM. 

HOWEVER, THIS INFORMATION DOES NOT POPULATE OTHER AREAS OF CERNER MILLENNIUM (INFORMATION DOES 

NOT FLOW “UP-STREAM”), SO ANY CHANGES HERE ARE STRICTLY FOR THIS CLAIM, IN ORDER TO ALLOW THE CLAIM 

TO PROCESS ONWARD, AND WILL NOT BE REFLECTED ANYWHERE ELSE ON THIS PATIENT’S ENCOUNTER.  
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Complete the following steps to update this claim and send out:  

8. Drag the Validation window over to allow you to see the Bill Record Browser window. 

9. Click the Value box corresponding to the validation error. 

10. Enter appropriate value and press Enter. 

11. Repeat this process to resolve each Validation error. 

12. When finished, click OK in the validation window. 

13. Click Validate on the Bill Record Browser toolbar. You will see a window that indicates all Validation Errors have been 

resolved and validation has completed successfully. 

14. Click the View tab in Bill Record Browser to view the claim one last time before submitting. 

15. Click Submit Batch to submit this particular claim to a batch of other claims ready to be sent out to the claims scrubber. 

Message is displays indicating the claim was submitted successfully. 

16. Click OK. 
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17. Click Close . Claim window closes. 

18. Click OK. Validation window closes. 

19. Close the claim window and take appropriate action.  

• Cancel claim 

• Correction action 

• Regenerating claim 

• Apply action code to record work done 

NOTE: SITES USING INTEGRATED CLAIMS SCRUBBING WILL RECEIVE CLAIM EDITS IN THE FORM OF A WORK ITEM. 

ONCE THE EDIT IS RESOLVED, THE END USER WILL APPLY AN ACTION CODE THAT COMPLETES THE ACTION OF RE-

GENERATING THE CLAIM. 

WORKING THE LATE CHARGE REVIEW QUEUE 

The Late Charges Review queue contains submitted claims with late charges, that will be manually resolved based on user-defined 

late charge processing rules. Items dequeue from the Late Charge queue by manually crediting or adjusting the charge or generating 

a claim. 

Complete the following steps to investigate late charges using the Late Charge Review queue: 

1. In Revenue Cycle (RevenueCycle.exe), select the Workflow view and double-click the Late Charge Review queue. Work 

items and available filters are displayed.  
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2. Double-click a queue item. The patient account is displayed.  

 

 

3. Select the Charges view. A red exclamation point indicates the late charge.  

 

 

NOTE: THE LATE CHARGE OPERATIONS JOB CAN AUTOMATICALLY BE CONFIGURED TO REGENERATE THE CLAIM WITH 

JUST LATE CHARGES OR REGENERATE THE ENTIRE BILL. IT CAN ALSO ADJUST, CREDIT, OR WRITE OFF CHARGES 

AUTOMATICALLY. 

4. Review and take appropriate action. 

Bill late charges on a late charge claim or a replacement claim 

• Manually write off the charge 

• Credit the charge 

• Modify charge information 

• Generate a claim 

• Apply an action code to record work done 

• Reassign a work queue item 

  

https://wiki.cerner.com/display/1101profitHP/Billing+Late+Charges-Late+Charge+Only+Claim+Using+Revenue+Cycle
https://wiki.cerner.com/display/1101profitHP/Billing+Late+Charges-Replacement+Claim+Using+Revenue+Cycle
https://wiki.cerner.com/display/1101profitHP/Writing+Off+a+Charge+Using+Revenue+Cycle
https://wiki.cerner.com/display/1101profitHP/Crediting+a+Charge+Using+Revenue+Cycle
https://wiki.cerner.com/display/1101profitHP/Modifying+Charge+Information+Using+Revenue+Cycle
https://wiki.cerner.com/display/1101profitHP/Overview+of+the+Manual+Claim+Generation+and+Validation+Workflow
https://wiki.cerner.com/display/1101profitHP/Applying+an+Action+Code+to+Record+an+External+Event+Using+Revenue+Cycle
https://wiki.cerner.com/display/1101profitHP/Reassigning+a+Work+Queue+Item+Using+Revenue+Cycle
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WORKING THE PENDING EDIT CLAIM QUEUE 

The Pending Edit state represents when a claim has been submitted but not transmitted. This state is only used for sites that use the 

transmission date functionality back from the scrubber. It is necessary to review claims in your scrubber to verify it has been sent to 

the payer. Claims are released from this work queue once the claim status changes to transmitted, which may need to occur 

manually. Claims with older dates should be monitored closely. 

Complete the following steps to monitor the claims that are in a status of pending edit: 

1. In Revenue Cycle (RevenueCycle.exe) open the Workflow view and double-click the Pending Edit Claim queue. The work 

items and available filters are displayed.  
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2. Review dates and take appropriate action: 

3. Ensure that the claim has been transmitted. 

4. Apply an action code to record the work done. 

WORKING THE DEMOGRAPHIC MODIFICATIONS QUEUE 

As registration modifications (RM) are processed, certain circumstances will cause the encounter to be queued to the Demographics 

Modifications workflow queue. The queue item is assigned a reason for its presence and identifies additional steps that may be 

required to bring the modification to full resolution. 

Complete the following steps to review the reason for the work item and take appropriate action: 
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1. In Revenue Cycle (RevenueCycle.exe) navigate to the Workflow tab and double-click the Demographic Modifications queue. 

The work items and available filters are displayed.  

 

 

 

 

 

2. Select a work item. 
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3. Review the reason and take appropriate action.  

 

 

DEMOGRAPHIC MODIFICATION REASONS 

 

The reasons for encounters to be queued to the Demographics Modifications workflow queue and the appropriate actions to take, 

are as follows: 

A SUSPENDED CHARGE ON THIS ENCOUNTER HAS PREVENTED REGISTRATION MODIFICATIONS FROM COMPLETING. 

Queue Event: During the processing of a RM certain circumstances will cause a charge to be reevaluated and as a result, credited 

and subsequently debited with the updated information. In order to preserve the accuracy and integrity of the revenue that has 

already been collected on the encounter, the RM will not complete if either the credit or new debit suspend during their creation 

and posting. If such a scenario occurs the encounter will be queued and requires further manual evaluation. 

Action to Take: For each offending charge, the system will store the suspense reason of the credit and or the new debit so you can 

make any necessary modifications to the encounter or the system build to allow the charge to successfully reevaluate. 

1. Use the Suspended Charges by Person Report (RMSC-01) report. The report can be run for all RMs that have failed due to a 

suspended charge, or for a single encounter. Each offending charge is listed in the report along with the reason for the 

suspense. 

2. Make necessary modifications. 

3. Reevaluate registration modification by opening the registration conversation and clicking to Save or Complete. If the 

reevaluation is successful, the queue item will be automatically removed from the workflow queue. 

A FAILED ATTEMPT TO LOCK THIS ENCOUNTER HAS PREVENTED REGISTRATION MODIFICATIONS FROM COMPLETING. 
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Queue Event: During the processing of a RM the system will attempt to gain exclusive access to the encounter prior to processing it. 

If exclusive access cannot be obtained, then the system cannot reliably process the RM. If such a scenario occurs the encounter will 

be queued. 

Action to Take: At a later moment you can reevaluate the registration modification by opening the registration conversation and 

clicking to Save or Complete. If exclusive access is obtained and if the reevaluation is successful, the queue item will be automatically 

removed from the workflow queue. 

AN INVALID COORDINATION OF BENEFITS ON THIS ENCOUNTER HAS PREVENTED REGISTRATION MODIFICATIONS FROM 

COMPLETING. 

Queue Event: During the processing of a Registration Modification the system evaluates the coordination of benefits entered during 

registration for correctness. Overlapping health plans coverage dates, as well as gaps in health plan priority sequence are not valid. If 

such a scenario occurs the encounter will be queued and requires further manual evaluation. 

Action to Take: To resolve the issue, make the appropriate modifications to the coordination of benefits in registration. When the 

modification to the coordination of benefits is made, the system will automatically reevaluate the RM. If the coordination of benefits 

is valid and the RM is successfully evaluated, the queue item will be automatically removed from the workflow queue. 

NOTE: CLINICAL ENCOUNTERS WILL ALSO QUEUE AND DEQUEUE IN THE DEMOGRAPHIC MODIFICATIONS QUEUE IF A 

HEALTH PLAN IS ADDED OR REMOVED AND THERE IS AN INVALID COORDINATION OF BENEFITS. 

APPLYING ACTION CODES 

Action codes allow you to add system-generated comments to track your productivity based on your initiated actions. These action 

codes trigger a comment corresponding to the specific action. You can add user-defined events to specific action codes. These 

events display action that happens outside of your system. 

Apply an Action Code task is available in the following views: 

• Balances 

• Charges 

• Claims 

• Encounters 

• Patient Account 

• Related Balances 

• Related Encounters 

• Statements 

• Workflow (My Workflow) 

• Workflow (Patient Account) 

• Workflow Follow-up 

BUSINESS RULES AND NOTES 

• Multiple select capability: You can select multiple items at once and apply to same task to all. To select several single items, 

hold down the CTRL button and click each item. To select several items that are grouped together, hold down the SHIFT 

button and click the first item, then click the last item. These can be used together to select a set of items (using SHIFT) and 

then deselect certain items from that range (using CTRL).  



100 
 

• Action codes can be configured to resolve and remove a work item as well as removing an associated hold.  

• Action codes can be configured to automate system actions. 

Complete the following steps to apply an action code to record an external event:  

1. Right-click the item or click View Menu and select Apply Action Code. The Apply Action Code dialog window is 

displayed.  

 

 
2. Enter the action code, or select it from the list. Press space bar in the Action Code box to pull up options. 

3. Complete any additional criteria boxes.  

o If the option is available, you can enter an amount of time for when you want the queue item to display back in 

your workflow. 

o If the option is available, you can forward the queue item to another individual's workflow for review. In the 

Personnel section, you can search for the person to whom you want to forward the balance or encounter.  

▪ Refer Queue Item: If a queue item needs to be transferred to another collector or manager, refer the 

queue item to the appropriate person's referral workqueue. It is important to note that the original queue 

item will remain in the queue. The system will send a referral queue item to the referral workqueue for 

follow-up. Recommended Follow-Up Time is one to three days. 

4. Click OK. The action code is recorded. Comments created by entering action codes in Workflow are displayed in the 

Comments view. 

FAILURE SCENARIOS 

OVERLAP IN COVERAGE 

Health plans on the same priority sequence have overlapping coverage dates. This will cause a failure because we do not know 

which health plan to bill as primary during the overlapping time frame. To resolve check the encounter health plan coverage 

associated to the encounter 
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GAP IN COVERAGE 

No primary health plan but there is a secondary health plan.  This will cause a failure because we do not know which plan should be 

billed as primary 

 

Gap between two health plans coverage on the same priority sequence, but full coverage in next priority sequence health plan.  This 

will cause a failure because we do not know which plan should be billed as primary during the gap in coverage. 

 

Coverage expires for health plan prior to 12/31/2100 end effective but full coverage in next priority sequence health plan with 

12/31/2100 end effective.  This causes a failure because the system finds at a given time there is no primary but there is a 
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secondary.  

 

SELF-PAY FINANCIAL CLASS ISSUES 

Primary is Self-pay financial class and Secondary is a health plan.  Same if secondary is Self-pay financial class and tertiary is health 

plan.  This causes a failure because we do not know which plan we should billed as self-pay. 

 

Multiple priority sequences have Self pay financial class. This causes a failure because we do not know which plan we should billed 

as self-pay. 
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THIS ENCOUNTER IS IN BAD DEBT AND HAS BEEN AFFECTED BY A REGISTRATION MODIFICATION. 

Queue Event: The system will process a RM on an encounter in bad debt; however, in certain circumstances additional manual steps 

are most likely required to fully bring the RM to resolution. One such example is that a health plan has been added to the encounter. 

If a health plan has been added to an encounter in bad debt, the user must determine if it is now appropriate for the encounter to 

be removed from bad debt and the insurance be billed. If such a scenario occurs the encounter will be queued and requires further 

manual evaluation. 

Another example is the encounter type was changed. If the encounter type has been changed to an encounter in bad debt, the user 

must determine if it is now appropriate for the encounter to be removed from bad debt. If such a scenario occurs the encounter will 

be queued and requires further manual evaluation. 

Action to Take: The most appropriate steps to resolution are to be determined by you based on the state of the encounter and the 

type of modification that was made. For any significant modifications made to the encounter, a comment is added indicating the 

change that was made. When you are sufficiently satisfied that all necessary steps have been taken to bring the RM to full 

resolution, you can remove the item from the queue using the 'Manually Release' option from workflow.  

THIS ENCOUNTER IS NOW ASSOCIATED TO A GUARANTOR WITH AN EXISTING FORMAL PAYMENT PLAN. 

Queue Event: If during the processing of a RM, the guarantor of the encounter is either changed or added, the system may queue 

the encounter to workflow if the new guarantor is already assigned to a formal payment plan of another encounter. This would 

indicate that the guarantor is already responsible for the balance(s) of other encounter(s) in the system, and as such, may be 

responsible for this encounter’s balance as well. If this scenario occurs, the system will not automatically associate the encounter to 

the formal payment plan; however, it will queue the encounter to workflow for further manual evaluation. 

Action to Take: If it is determined by manual evaluation that the guarantor should be responsible for this encounter balance then 

you can associate the encounter to the formal payment plan, update the installment amounts as needed, and alert the guarantor to 

changes in the formal payment plan. When you are satisfied that all necessary steps have been taken to bring the RM to full 

resolution, you can remove the item from the queue using the 'Manual Release' option from workflow.  

THE GUARANTOR ASSOCIATED TO THIS ENCOUNTER HAS BEEN REMOVED. 

Queue Event: If during the processing of a RM, the guarantor of the encounter is removed, the system will not be able to correctly 

determine the party responsible for the self-pay balance and will no longer generate statements. If such a scenario occurs the 

encounter will be queued and requires further manual evaluation. 

Action to Take: You must add a guarantor in registration to whom the self-pay balance will be billed. When the modification to the 

guarantor is made, the system will automatically reevaluate the RM. When you are satisfied that all necessary steps have been taken 

to bring the RM to full resolution, you can remove the item from the queue using the 'Manual Release' option from workflow.  

PRIMARY HEALTH PLAN REMOVED. EVALUATE FORMAL PAYMENT PLAN  

Queue Event: If the primary health plan is removed from an encounter which is associated to a formal payment plan, then the terms 

of the formal payment plan most likely need to be updated. If such a scenario occurs the encounter will be queued and requires 

further manual evaluation. 

Action to Take: If it is determined that the terms of the formal payment plan should be updated then the user can update the 

installment amounts as needed and alert the guarantor to changes in the formal payment plan. When you are satisfied that all 
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necessary steps have been taken to bring the RM to full resolution, you can remove the item from the queue using the Manual 

Release option from workflow.  

THIS ENCOUNTER HAS BEEN REMOVED FROM A FORMAL PAYMENT PLAN WHICH NOW NEEDS TO BE EVALUATED FOR 

CHANGES. 

Queue Event: During the processing of a RM certain circumstances will cause the encounter to be removed from the formal 

payment plan it is currently associated to. If the formal payment plan is tied to other encounters, then the terms of the payment 

plan might need to be updated to reflect the removal of this encounters balance. If such a scenario occurs the encounter will be 

queued and requires further evaluation. 

Action to Take: If it is determined that the terms of the formal payment plan should be updated then you can update the installment 

amounts as needed and alert the guarantor to changes in the formal payment plan. When you are satisfied that all necessary steps 

have been taken to bring the RM to full resolution, you can remove the item from the queue using the Manual Release option from 

workflow.  

THIS ENCOUNTER HAS A PERSON MANAGEMENT CHARGE THAT HAS BEEN CREDITED DUE TO AN ENCOUNTER TYPE 

CHANGE. 

Queue Event: When modifying the encounter type to or from a recurring encounter, all PM charges currently associated to the 

encounter will be credited. If such a scenario occurs the encounter will be queued and requires further evaluation. 

Action to Take: If it is determined that the PM charges are valid and should exist on the encounter, you can debit those charges 

again using Charge Batch Entry. When you are satisfied that all necessary steps have been taken to bring the RM to full resolution, 

you can remove the item from the queue using the Manual Release option from workflow.   

CERNER CONTRACT MANAGEMENT 

The encounter had charges that either re-tiered, had bill code changes, or were unable to process. The modifications cannot bypass 

re-billing with these conditions. 

Queue Event: Alternate Repricing option selected with encounter modification that caused charge changes to occur (bill code 

change, price change, or re-tier due to interface file) and did not qualify for PBM exception rule. 

Action to Take: Add the PBM exception rule or update the charge build. You will need to select Alternate Repricing from the Pricing 

Details window, select Skip Rebill for the health plan change previously attempted OR in Registration, complete a regular encounter 

modification that will activate a rebill modification. 

THE ENCOUNTER MODIFICATION HAD NO PRIMARY HEALTH PLAN CHANGE OR HAD ADDITIONAL MODIFICATIONS 

BEYOND THE PRIMARY HEALTH PLAN. THE MODIFICATION CANNOT BYPASS RE-BILLING WITH THESE CONDITIONS 

Queue Event: Alternate Repricing option selected with encounter modification, where more than a primary HP modification 

occurred, or no health plan modification occurred. This could also occur when there is another encounter modification in process. 

Action to Take: Select Alternate Repricing from the Pricing Details window, select Skip Rebill for the health plan change previously 

attempted OR in Registration, complete a regular encounter modification that will activate a rebill modification. 
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NOTES: IF AFTER PERFORMING THE ALTERNATE REPRICING ACTION PROCESS AND THE MODIFICATION IS NOT 

RESOLVED, LOG AN SR TO CERNER SUPPORT USING ESERVICE AND INCLUDE THE FOLLOWING: 

• Financial Number (FIN #) 

• Claim Number (if applicable) 

• Synopsis of issue 

Clicking the Skip Rebill button triggers a Skip Rebill modification. 

WORKING THE ENCOUNTER COMBINES QUEUE 

The Encounter Combines queue contains encounters that cannot be combined on the financial side due to one encounter either 

being in collections, containing overlapping dates of service, contains a submitted claim, or one of the encounters is a recurring 

encounter. 

Complete the following steps to work the Encounter Combines queue: 

1. In Revenue Cycle (RevenueCycle.exe), select the Workflow view and double-click the Encounter Combines queue. The work 

items and available filters are displayed.  

 

 

 

https://eservice.ucern.com/default.aspx
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2. Double-click a queue item. The patient account is displayed with the encounter in context and the workflow toolbar 

displayed.  

 

 
3. Review account information and take appropriate action. 

4. Apply an action code to record your work and manually release the queue item. 

Action codes allow you to add system-generated comments to track your productivity based on your initiated actions. These action 

codes trigger a comment corresponding to the specific action. You can add user-defined events to specific action codes. These 

events display action that happens outside of your system. 
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Apply an Action Code task is available in the following views: 

• Balances 

• Charges 

• Claims 

• Encounters 

• Patient Account 

• Related Balances 

• Related Encounters 

• Statements 

• Workflow (My Workflow) 

• Workflow (Patient Account) 

• Workflow Follow-up 

Business Rules and Notes 

Multiple select capability: You can select multiple items at once and apply to same task to all. To select several single items, hold 

down the CTRL button and click each item. To select several items that are grouped together, hold down the SHIFT button and click 

the first item, then click the last item. These can be used together to select a set of items (using SHIFT) and then deselect certain 

items from that range (using CTRL).  

• Action codes can be configured to resolve and remove a work item as well as removing an associated hold.  

• Action codes can be configured to automate system actions. 

Complete the following steps to apply an action code to record an external event:  

1. Right-click the item or click View Menu and select Apply Action Code. The Apply Action Code dialog window is 

displayed.  

 

 
2. Enter the action code or select it from the list. Press space bar in the Action Code box to pull up options. 

3. Complete any additional criteria boxes.  

• If the option is available, you can enter an amount of time for when you want the queue item to display back in your 

workflow. 
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• If the option is available, you can forward the queue item to another individual's workflow for review. In the Personnel 

section, you can search for the person to whom you want to forward the balance or encounter.  

Refer Queue Item: If a queue item needs to be transferred to another collector or manager, refer the queue item to the appropriate 

person's referral work queue. It is important to note that the original queue item will remain in the queue. The system will send a 

referral queue item to the referral work queue for follow-up. Recommended Follow-Up Time is one to three days. 

4. Click OK. The action code is recorded. Comments created by entering action codes in Workflow are displayed in the 

Comments view. 

RELEASING A WORK QUEUE ITEM WITH FOLLOW-UP 

You can release a work queue item from the Workflow view for a defined period of time. The entity returns to the workflow after 

the defined period has elapsed. You can also add more time in the Follow-Up view.  

Complete the following steps to release a work queue item with a follow-up: 

1. Identify a queue item. For this example, use a work queue item from the Follow-up view. 

2. Right-click the queue item or click and select Release with Follow-Up.  
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3. The Release with Follow-up dialog box is displayed.  

 

 

1. Select a review date. 

2. Enter a comment. 

3. Select a pre-defined comment. 

4. Select an importance flag. 
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5. Click OK 

 

 

MANAGING WORK ITEMS 

Work items are designed to help facilities route work and resolve issues within the Cerner Millennium system. With this workflow, 

you can identify business problems, manually or by the system, and assigned to the correct users or departments for resolution. The 

Work Items functionality offers multiple options and setup possibilities to enhance workflows. 

Identifying a Work Item 

The Identify Work Item task enables you to identify specific entities as having issues that need to be resolved. You can assign the 

work item to a person or department. You can search for and assign personnel or departments in the facility associated to the entity 

identified, to resolve the issue identified. In order to assign issues to a department, departments must be configured. When a 

department is selected, the issue or work item is assigned to a person in the department depending first on if a person is already 

working on the balance or encounter, and then based on workload of personnel in the department. 

When an issue is identified for a clinical encounter, it is associated to the financial encounter associated to the clinical encounter in 

context. If there are more than one financial encounter associated to the clinical encounter, the issue is associated with the most 

recent financial encounter. 

This task is available from the following views: 

• Balances 

• Encounters 

• Claims 

• Workflow 

The following attributes are available within the Work Item Definition task: 

• Work Item Alias: Allows you to filter by the name of the work item. 

• Responsible: Allows you filter by the party responsible for the work item. 
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Check one of the following to filter on: 

• Department 

• Personnel 

• Assignment Rule 

• Description: Free text field to enter a comment viewable by the responsible party for the outgoing Work Item. 

• Preview Box: Must be unchecked to enter description notes. 

Complete the following steps to identify a work item: 

1. From the appropriate view, click the View Menu (down arrow) and select . The Identify Work 

Item dialog box is displayed.  

 

2. Press space bar in the Work Item Alias Box to pull up options. The corresponding Work Item Alias can also be entered in this 

box. This box also allows for you to type in the selection if known.  

 

 
3. Double-click to select alias. The personnel populates based on the alias chosen and yellow highlight on the field will 

disappear.  

 

 
4. Enter note into the description box. 

5. Click Add to review before submitting. 

6. Click OK. The encounter is sent to the the assigned queue and a billing hold is assigned if appropriate based on Work Item 

Alias chosen. 

RESOLVING A WORK ITEM 



112 
 

Once a work item is created, either manually or through a system event, it must be resolved. There are two mechanisms for 

resolving a Work Item, from Revenue Cycle or Discern Notification. 

NOTE: EVERY WORK ITEM IS CREATED AS PART OF A SPECIFIC WORKFLOW. THE STEPS OUTLINED ON THIS PAGE ONLY 

ILLUSTRATE THE STEPS TAKEN TO RESOLVE THE WORK ITEM ITSELF AND NOT FOR A SPECIFIC WORKFLOW. A WORK 

ITEM SHOULD ONLY BE RESOLVED ONCE ALL ISSUES RELATED TO THE SPECIFIC WORKFLOW ITSELF HAVE BEEN 

RESOLVED. 

Resolving from Revenue Cycle 

Work items are displayed in Revenue Cycle similarly to state-based or exception queue items. 

Complete the following steps to resolve a work item in Revenue Cycle:  

1. Double-click on the queue.  

2. Select a work item and expand the work item details.  

 

 
3. Review the comments and take the appropriate action to correct the identified issue.  

4. Once the issue has been resolved, right click on the Work Item from the queue and select Apply Action Code  
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5. Select the Action Code that will resolve the Work Item, and enter any appropriate comments.  

 

 

NOTE: WORK ITEMS ARE CONFIGURED TO ACCEPT SPECIFIC ACTION CODES FOR RESOLUTION. IF THE ACTION CODE 

SELECTED WAS NOT IDENTIFIED AS ABLE TO RESOLVE THE WORK ITEM, THE WORK ITEM WILL NOT BE RESOLVED. 

YOU MUST SELECT THE CORRECT ACTION CODE TO RESOLVE THE ITEM. 

6. Once the Action Code is applied, the work item is resolved and is removed from the queue.  

 

 

RESOLVING FROM DISCERN NOTIFICATION 

For end-users that do not access Revenue Cycle, work items may still be assigned to them and resolved through Discern Notification. 

The Work Item is displayed as an individual message in the application with details similar to the view in Revenue Cycle. From 

Discern Notification, you can access the following applications:  

• PowerChart 

• SurgiNet 

• FirstNet 

Selecting any of these options from the Task menu opens the selected application directly into the patient record for the identified 

Work Item, allowing any corrections to be made. Once the appropriate action has been taken, the Work Item may be resolved. 

Complete the following steps to resolve a work item in Discern Notification: 
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1. Select a work item. The Work Item details are displayed.  

 

 
2. Review the work item, and from the Task menu on the right-hand side of the dialog box, access the appropriate application.  

3. Once all issues have been corrected, enter any appropriate comments and click the Resolve link to apply the action code. 

The work item is resolved. 

MANAGING BILLING HOLDS 

APPLYING A BILLING HOLD 

You can select a billing hold from a defined list and apply the hold to a financial encounter or balance. The hold must be user-defined 

and not already applied to an encounter or balance. This task is available from the Balances, Encounters, and Related Balances 

views.  

Complete the following steps to add a billing hold: 

 

1. Access the appropriate view to place a hold. 

2. Click the drop down arrow , or right-click to display the task list. 

3. Select Add Billing Hold. The Add Billing Hold dialog box is displayed. 
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4. Select the appropriate billing hold, and enter a reason. 

  

 
  

5. Click OK. 

REMOVING A BILLING HOLD 

 

The Remove Billing Hold task allows you to remove a billing hold from a financial encounter or balance. This task is available from 

the Billing Holds view.  

Complete the following steps to remove a billing hold: 
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1. Select the Billing Holds view. 

   

 
   

If Billing Holds is not displayed, click from the toolbar and select Billing Holds. It will now display as a tab at the bottom of the 

screen. 

2. Right click on billing hold or click the to display the task list. 

   

3. Select Remove Billing Hold. The Remove Billing Hold window will be displayed. 
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4. Click Yes. 

   

 
   

5. The billing hold has been removed. 
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WORKING THE CREDIT BALANCE INVOICE QUEUE  

Credit Balance invoices contain a credit balance because payments and adjustments posted to the account have exceeded the client 

balance. Good Standing and Past Due invoices are sent to the queue when a payment or adjustment results in a credit balance. They 

are removed when transactions are applied that result in a zero balance or a charge. 

Complete the following steps to investigate credit balance invoices: 

1. In Revenue Cycle (RevenueCycle.exe) access the Workflow tab, and double-click the Credit Balance Invoice queue. Work 

items and available filters are displayed.  

 

  

• The available filters are: 

• Client Account 

• Billing Entity 

• Status 

• Status Date 

• The available sort options are: 

• Status Date (This is the default) 

• Amount 

• Ascending 

• Descending 



119 
 

 

 

 

2. Double-click a queue item. The client account information is displayed in the Bill Record Browser.  

 

 
 

From the Bill Record Browser Info tab, you can view other remarks or comments, and you can add a new comment.  
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3. If you want to apply an action code, close the Bill Record Browser window. Then, click the down arrow at the top of the 

Workflow tab. 

 

NOTE: YOU CAN ALSO ADD AN ACTION CODE BY RIGHT-CLICKING A QUEUE ITEM AFTER THE QUEUE IS DISPLAYED. 
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4. From the menu, select Apply Action Code. The system displays the Action Entry dialog box.  
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5. In the Action Entry dialog box, you can select a predefined action code from the list, or you can add a free text comment, or 

you can select a pre-defined comment. 

 
6. When you have completed entering the details you want for applying comments or an action code, click Save. 

7. Take any additional appropriate actions you want. 

• Review registration information 

• Apply a refund 

COMPLETE THE FOLLOWING TWO STEPS TO APPLY A REFUND: 

1. Apply an adjustment for the credit balance invoice amount. See the help topic for Adjusting a Client Invoice Using Revenue 

Cycle. 

2. Generate a manual check from your accounts payable system. 

a. Cancel or write off the amount 

b. Reassign the queue item to someone else to work 

c. Apply an action code (payer follow up) to record work done 

3. Once you have completed your work on the queue item, click the down arrow in the Workflow Navigation Bar to move to 

the next item in your queue. 

APPLYING AN ACTION CODE 

Action codes allow you to add system-generated comments to track your productivity based on your initiated actions. These action 

codes trigger a comment corresponding to the specific action. You can add user-defined events to specific action codes. These 

events display action that happens outside of your system. 

Apply an Action Code task is available in the following views: 

https://wiki.cerner.com/pages/createpage.action?spaceKey=1101profitHP&title=Adjusting+a+Client+Invoice+Using+Revenue+Cycle&linkCreation=true&fromPageId=1261606375
https://wiki.cerner.com/pages/createpage.action?spaceKey=1101profitHP&title=Adjusting+a+Client+Invoice+Using+Revenue+Cycle&linkCreation=true&fromPageId=1261606375
https://wiki.cerner.com/display/1101profitHP/Applying+an+Action+Code+to+Record+an+External+Event+Using+Revenue+Cycle
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• Balances 

• Charges 

• Claims 

• Encounters 

• Patient Account 

• Related Balances 

• Related Encounters 

• Statements 

• Workflow (My Workflow) 

• Workflow (Patient Account) 

• Workflow Follow-up 

BUSINESS RULES AND NOTES 

• Multiple select capability: You can select multiple items at once and apply to same task to all. To select several single items, 

hold down the CTRL button and click each item. To select several items that are grouped together, hold down the SHIFT 

button and click the first item, then click the last item. These can be used together to select a set of items (using SHIFT) and 

then deselect certain items from that range (using CTRL).  

• Action codes can be configured to resolve and remove a work item as well as removing an associated hold.  

• Action codes can be configured to automate system actions. 

Complete the following steps to apply an action code to record an external event:  

1. Right-click the item or click View Menu and select Apply Action Code. The Apply Action Code dialog window is 

displayed.  

 

 
2. Enter the action code or select it from the list. Press space bar in the Action Code box to pull up options. 

3. Complete any additional criteria boxes.  

• If the option is available, you can enter an amount of time for when you want the queue item to display back in 

your workflow. 
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• If the option is available, you can forward the queue item to another individual's workflow for review. In the 

Personnel section, you can search for the person to whom you want to forward the balance or encounter.  

• Refer Queue Item: If a queue item needs to be transferred to another collector or manager, refer the 

queue item to the appropriate person's referral workqueue. It is important to note that the original queue 

item will remain in the queue. The system will send a referral queue item to the referral workqueue for 

follow-up. Recommended Follow-Up Time is one to three days. 

4. Click OK. The action code is recorded. Comments created by entering action codes in Workflow are displayed in the 

Comments view. 

REASSIGNING A WORK QUEUE ITEM 

The Reassign task allows you to reassign one to many work queue items to other personnel. You can also apply a comment when 

reassigning the work queue items. This task is available from the Follow-Up and the Workflow tabs.  

Complete the following steps to reassign a work queue item: 

1. Right-click the work item and select Reassign.  

 

 

NOTE: MULTI-SELECT CAPABLE — WORK QUEUES ARE CAPABLE OF ALLOWING MULTIPLE SELECTIONS AT ONCE AND 

THE SAME TASK CAN BE APPLIED TO ALL OF THEM. TO SELECT SEVERAL SINGLE ITEMS, HOLD DOWN THE CTRL 

BUTTON AND CLICK EACH ITEM. TO SELECT SEVERAL ITEMS THAT ARE ALL GROUPED TOGETHER, HOLD DOWN THE 

SHIFT BUTTON AND CLICK THE TOP ITEM, THEN CLICK THE BOTTOM ITEM. THESE CAN BE USED TOGETHER TO SELECT 

A SET OF ITEMS (USING SHIFT) AND THEN DESELECT CERTAIN ITEMS FROM THAT RANGE (USING CTRL). 



125 
 

 

2. The Reassign dialog box is displayed.  

 

 
3. Enter the name of the person you want to reassign to or select the magnifying glass to search for the person. 

4. Enter a comment.  
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5. If appropriate, select a Predefined Comment from the list.  

 

 
6. If appropriate, change the importance indicator by selecting from the list.  

 

 
7. Click OK. Work queue items are reassigned. 
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NOTE: QUEUE ITEM REVIEW - IF THERE IS NO CLEAR INDICATION AS TO WHY A QUEUE ITEM IS NOT RELEASING FROM 

THIS QUEUE, PLEASE LOG A SERVICE REQUEST (SR) TO CERNER SUPPORT USING ESERVICE. WHEN YOU LOG AN SR, 

PLEASE INCLUDE THE FOLLOWING INFORMATION: 

• Account information 

• Invoice number 

• Summary of issue 

MANAGING PATIENT STATEMENTS 

GENERATING MANUAL STATEMENTS 

Manually generated statements are used for on-demand scenarios, such as when a patient comes into the business office to make a 

payment and requests an updated statement reflecting the amount just paid. If you need to generate a statement on demand, you 

can generate it from the Encounters tab or the Balances tab. After a statement is manually generated, it is identified on the 

Statements tab with an On-Demand icon to differentiate it.  

NOTE: MANUAL STATEMENTS ARE NOT SENT TO STATEMENT VENDORS AND DO NOT AFFECT THAT STATEMENT CYCLE 

ON THE ACCOUNT. 

1. In the Encounters view, click the down arrow ( ) and select Generate Statement.  

 
2. Click the boxes for Summarize Charges and Summarize Payments and Adjustments as necessary. 

3. Select the statement date range you want. 

4. Select Activity Date or Posted Date. 

https://eservice.ucern.com/default.aspx
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5. Click OK.  
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MODIFYING STATEMENT CYCLES 

1.  In the Encounters view, click the drop-down arrow ( ) and select Statement Cycle. 

  

 
  

2. Select the statement cycle, the guarantor (if available), and the next statement date. 

 

1. Click OK. 



130 
 

APPLYING FORMAL PAYMENT PLANS 

You can apply a formal payment plan on an encounter. The plan allows the system to generate billing statements and to track the 

collection of payments.  

 

Complete the following steps to apply a formal payment plan on an encounter: 

1. Click the drop-down arrow ( ) from the Encounters or Patient Account view. The task list is displayed. 

2. Select Formal Payment Plan. 

3. Select all the encounters you want to include in the formal payment plan. When you select an encounter, the amount owed 

on the encounter is added to the Total Plan Amount. 

4. Complete payment plan details, entering the installment amount or the number of installments, the cycle length, and when 

the first payment is due. If you enter an installment amount, the application calculates the number of installments, and if 

you enter a number of installments, the application calculates the installment amount.  

5. Click OK. The OK button is unavailable until the minimum installment amount is met. 

6. In the Encounter view, verify that the Payment Plan field is displayed in a Yes status. 

7. Position the pointer over the Information button ( ) to view detailed information about the payment plan. 
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GUARANTOR INFORMATION SECTION 

The Guarantor Information section displays the following data associated with the guarantor, and is not modifiable: 

• Name: Guarantor name 

• Address: Guarantor address 

• City: Guarantor city 

• Insurance Pending: Total of insurance balances 

• Self Pay Balance: Total of self pay balances 

• Credit Balance: Total dollar amount in credit balance 

• Bad Debt Balance: Total dollar amount in bad debt 

• Current Plan Payment: Dollar amount of established formal payment plans 

• Next Payment Due: Due date of established formal payment plans 

• Current Plan Status: Status of established formal payment plans 
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ENCOUNTERS SECTION 

This section allows you to multi-select the encounters you want included in the Formal Payment Plan you are creating. This 

section contains the following elements: 

• Total Plan Amount: The total combined balance of the encounters selected in the Encounters section. This information is 

auto-calculated and changes only if the encounters selected are changed. 

• Suggested Installment Amount: A system-calculated suggested installment amount. You can modify this value as long as it 

does not go below the established minimum for the Total Plan Amount. 

• Minimum Installment Amount: Minimum acceptable installment amount. This amount is client-defined and based on the 

Total Plan Amount. 

• Automated Payments: Populates the credit card information for monthly automatic payments. 

• Installment: Dollar amount that the guarantor and business office agree upon for future payments. You can modify this 

value as long as it does not go below the minimum established amount. 

• Number of Installments: Number of payments required to pay off the Total Plan Amount, based on the Installment Amount 

entered. If you modify this value, the Installment Amount is automatically updated. 

• Payment Frequency: How often the guarantor is required to make payments. 

• Cycle Length: How often an installment payment will be made. This box is defaulted to 30 days. 

• Next Payment Due:  Date that the next installment payment is due. When you first create the Formal Payment Plan, you 

can modify this value. However, this value should not be modified after a Formal Payment Plan is already established. If you 

modify this value after a Formal Payment Plan is established, the Next Bill Date value may be updated incorrectly and the 

guarantor credit card may be inaccurately charged. 

• Final Payment Date: Projected final payment date based on the data defined 
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APPLYING ADJUSTMENTS 

You can apply an adjustment to a: 

• Charge 

• Claim 

• Encounter 

This task is available from the Charges, Claims, Encounters, and Patient Account views.  

1. From the view menu ( ) in the Encounters or Patient Account view, select Apply Adjustment. The Apply an Adjustment 

dialog box is displayed. 
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2. Enter the adjustment amount, then click the magnifying glass icon next to the Benefit Order box to select a benefit order to 

apply the adjustment.  

3. Click OK.  
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4. Click the magnifying glass icon next to the Transaction Alias box and enter a transaction alias next to the Transaction Alias 

box. A transaction alias list is displayed.  

 

5. To make a selection, double-click a row in the Transaction Alias list. The system closes the list and adds the Transaction Alias 

number to the Transaction Alias box.  
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6. To add a comment, click Add Comment. The Add Comment dialog box is displayed and you can select a predefined 

comment, or you can add a comment using the free text entry box.  

 

 

7. When you have entered a comment, click Save. The comment is saved and displayed in the Patient Accounting perspective 

(for example, the Self-Pay Transactions view) for future reference. 

 

 

8. Select the appropriate the Subtype and Reason and click Apply. After you click Apply, the system prompts you to make 

certain you want to apply the adjustment. 
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NOTE: IF YOU CLICK CANCEL, THE SYSTEM TERMINATES THE ADJUSTMENT TRANSACTION 
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9. Click OK. A confirmation message is displayed.  

 

10. Click OK. The adjustment posting is completed and you are returned to the Patient Account perspective. In addition, a 

transaction reference is added to the grid at the bottom portion of the Patient Accounting perspective.  

 

TRANSFERRING BALANCES 

You can transfer partial balances in the same charge group. You can transfer that credit balance (or part of the last payment) to 

eliminate the credit balance and put the payment toward an existing balance. You cannot transfer balances in a Canceled, Void, or 

Invalid status. The "From" balance must have a valid insurance "To" balance in the same charge group or a valid self-pay "To" 

balance. This task is available from the Balances View and Related Balances View.  

1. Navigate to the Balances view and select the balance. 

2. Right-click and select Transfer Balance. The Transfer Balance window is displayed.  
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3. Click the drop-down arrow and select the "To" balance from the list.  

NOTE: WHEN THERE IS ONLY ONE AVAILABLE TO BALANCE AVAILABLE TO TRANSFER THE BALANCE TO, THE SYSTEM 

DISPLAYS THE BOX WITH THAT BALANCE BY DEFAULT. 
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4. Enter the amount to transfer.  

 

 
5. Click the drop-down arrow and select a transfer reason from the list.  
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6. Review Balance Transfer Summary.  

 

 
7. Click OK to complete transfer, or click Cancel to cancel the transfer. 

8. Review modification to balances in the Balances tab.  

NOTE: THE FROM BALANCE IS REDUCED OR INCREASED AS INDICATED BY THE TRANSFER IDENTIFIED AND AMOUNT. 

THE TO BALANCE IS REDUCED OR INCREASED AS INDICATED BY THE TRANSFER IDENTIFIED AND AMOUNT. A HISTORY 

OF THE CURRENT BALANCE TRANSFER IS RECORDED ALONG WITH THE REASON INDICATED. THE INFORMATION IS 

AVAILABLE IN THE ACTIVITY TAB. THE ACTIVITY TAB IS NOT A DEFAULT VIEW AND NEEDS TO BE ADDED IF YOU WANT 

TO VIEW THE INFORMATION ON A REGULAR BASIS. 

 

VIEWING A CHARGE 

OVERVIEW 

The Charges view displays charges associated with a patient account. Credit transactions replace the debit transaction in the list 

view with the debit transaction viewable in the detail. With a partial credit, the original debit is completely credited and a new debit 

charge with the new quantity is displayed. The supported contexts for this view are Balances, Claims, Clinical Encounter, Financial 

Encounter, and Patient Account. The default sort is Service Date in descending order.  
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Available columns for this view are listed below. 

• Late: In the Late column, a red exclamation point will indicate a late charge . 

• Type: Position the pointer over the icon in this column to display the type, such as Posted, Credited, Written Off, and 

Adjusted. 

• Status: A textual, detailed description of the status of the charge; including the billing status. 

• Posted - Unbilled: The charge has been posted but does not display on a claim that is currently in a billed status. 

• Posted - Billed: The charge has been posted and appears on a claim that is currently in a billed status. 

• Credited - Billed: The charge has been credited and is suppressed from appearing on all future claims. The charge is 

displayed on a claim that is currently in a billed status and that was generated prior to the charge being credited. Typically, 

in this scenario, the claim is canceled, and a replacement claim with the charge suppressed is submitted. 

• Credited - Suppressed: The charge has been credited and is suppressed from displaying on all future claims. The charge may 

have displayed on a claim prior to being credited. However, if the charge had displayed on a claim prior to being credited, 

that claim has since been canceled or denied. 

• Written Off - Unbilled: The charge has been written off (and write off adjustment has not been reversed) and the charge 

does not display on a claim that is currently in a billed status and a substatus of Late Charge Processing will be associated. 

• Written Off - Billed: The charge has been written off (and the write off adjustment has not been reversed) and the charge is 

displayed on a claim that is currently in a billed status and a substatus of Late Charge Processing will be associated. 
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• Adjusted - Unbilled: The charge has been adjusted (and the adjustment has not been reversed) and the charge does display 

appear on a claim that is currently in a billed status. 

• Adjusted - Billed: The charge has been adjusted (and the adjustment has not been reversed) and the charge displays on a 

claim that is currently in a billed status. 

• Service Date 

• Encounter: The financial encounter number is displayed. 

• HCPCS 

• Revenue Code 

• Units 

• Amount 

• Payments 

• Adjustments 

• Remaining Amount 

• Performing Provider: Populated with the performing physician. If no performing physician exists, then the verifying 

physician is used. If no verifying physician exists, then the ordering physician is used. 

• Coverage: The sequence of the health plan is displayed. 

• Description 

• ABN Status 

• Activity Date 

• Activity Type 

• AR GL Date 

• CDM 

• Charge Coinsurance Amount 

• CPT 

• Credited Date 

• Charge Deductible Amount 

• Diagnosis 

• GL AR 

• GL NonAR 

• ICD Procedure Code 

• Modifier 

• NDC 

• Ordering Provider 

• Original Amount 

• Original Units 

• Performing Location 

• Posted By 

• Unit Price 

• Updated By 

• Updated Comment 

• Updated Reason 

• Provider Specialty 

• Supervising Provider 

• Release Considerations 

• Supervising Provider and Provider Specialty may be generally available at a later date. This note will be updated or removed 

when this functionality is generally available.  

• Charge Detail Information 
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All available information for the charge is displayed in the detail view and preview pane. Icons displayed in the list view have the 

textual representation in the detail view and preview pane. Double-click a charge to view the detail view and set the charge in 

context, or you can click the up arrows at the bottom of the view to expand the preview pain. 

CHARGE IN CONTEXT  
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Preview Pane  

 

 

CHARGES VIEW TASKS 

The following tasks are available in the Charges view: 

• Apply Action Code 

• Apply Adjustment 

• Apply Comment 

• Credit 

• General Ledger Entries 

• Modify Charge 

• Modify Charge Group 

• Move Charge 

• Write Off  
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FILTERS 

The following predefined filters are available in the Charges view: 

• All 

• Adjusted 

• Credited 

• Posted 

• Written Off  

 

 
 

The following discrete filters are available: 

• Status: Adjusted, Credited, Posted, and Written Off. 

• Activity Type 

• Revenue Code: Free-text. 

• Description: Free-text. 

• Service Date 

• Late Charges: Include, Exclude. 

• Amount 

• HCPCS/CPT 

• Performing Provider 

• Activity Date 

• Category: Diagnostic Charges, Medically Related, Unscanned NDC. 
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NOTE: TO ADD A FILTER THAT IS NOT DISPLAYED, CLICK THE DOWN ARROW NEXT TO A FILTER YOU ARE NOT USING 

AND SELECT A FILTER FROM THE LIST TO REPLACE IT. 

NUMBER OF CHARGES DISPLAYED 

The number of charges available to view is displayed at the right top corner of the view.  

 

 
 

When the number of charges is larger than 125, click the down arrow to select a larger cap number. 2000 is the largest number of 

charges that can viewed at a time. When more than 2000 charges are available, a message is displayed. Use filters to reduce the 

number of charges and display only those you need.  

 

 

SUMS OF DOLLAR AMOUNTS 

In each grid view, columns that have dollar amounts are summed and displayed at the bottom of the grid. By default, all amounts 

listed in the row are summed. If a user multi-selects rows, only those rows that have been selected are summed. 

Editing Columns in the Charges View 

 

Complete the following steps to edit columns in the list:  
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1. Click View Menu and select View Layout > Edit.  

 

 

The Edit View Layout window is displayed 

 

 

2. Click the empty box next to the column label to select the column. Click the box with a blue check mark to un-select the 

column.  
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3. Move the columns up or down using the arrows, or drag and drop them in the order to be displayed.  

 

 
4. Click OK. Columns are displayed as selected. 

5. To save this preference, click View Menu and select View Layout > Save.  
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NOTE: TO SAVE THE VIEW LAYOUT FOR ALL USERS, FROM THE VIEW MENU, SELECT VIEW LAYOUT > SAVE 

CONFIGURATION. 

 

 

A message is displayed indicating layout has been saved.  

 

 

6. Click OK. 

To reset the layout back to the default, click View Menu and select View Layout > Reset. The default column layout will be 

displayed.  
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CREDITING A CHARGE 

Crediting a charge allows for crediting the entire amount of the charge and allows for crediting off a partial amount when multiple 

quantities are associated. When multiple quantities exist and a partial credit is applied, the residual quantity and amount are 

created in the system as a new debit and the original charge is credited.  

1. From the Charges view, select the appropriate charge. 

2. Right-click the charge or click View Menu and select Credit.  
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3. The credit window displays.  

 

 
4. If the quantity of charges is greater than one, you can select to credit all of them or specify the amount. 

5. Select a reason for the credit. Add additional comments if needed in Note.  
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6. Click OK. The charge is displayed as credited.  

 

 

NOTE: WHEN YOU CREDIT A CHARGE IN A SINGLE CHARGE PER CHARGE GROUP SCENARIO, AND THERE ARE NO 

OTHER TRANSACTIONS ASSOCIATED TO IT, THE BALANCE ASSOCIATED TO THE CHARGE WILL NO LONGER BE 

DISPLAYED. IF THERE ARE OTHER TRANSACTIONS ASSOCIATED TO THE CHARGE, THE ASSOCIATED BALANCE WILL BE 

DISPLAYED WITH A STATUS OF VOID. 

WRITING OFF A CHARGE 

You can apply an adjustment for the entire charge amount and flag the charge for late charge processing using the Write Off task. 

This task is available from the Charges view.  

1. Locate the Charges view. 

2. Right-click charge or click View Menu to display the task list. 

3. Select Write Off. The Write Off window is displayed.  
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4. Click Yes to write off the charge. Message will display asking you to confirm action.  

 

 
 

 
5. Click OK. The charge will show as written off under the Charges view.  

 

 
6. Locate the appropriate transactions view to see the late charge adjustment created.  
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MODIFYING A CHARGE 

The Modify Charge Information task is available from the Charges view. You can modify charge information for a charge when 

appropriate. 

1. In the Charges view, right-click a charge and select Modify Charge. 

2. Right-click a charge or click View Menu  to display the task list. 

3. Select Modify Charge. The Modify Charge dialog box is displayed. 

4. Make any necessary modifications in the  

• General 

• Codes 

• Other 

5. Click OK to save your changes. The columns in the Charges tab reflect the changes. 

 

MOVING A CHARGE 

 

The Move Charges task allows you to move charges from one encounter to another. If you perform this task at the encounter level, 

all charges are moved. You can move charges individually at the charge level.  

ENCOUNTER LEVEL  

 

Complete the following steps to move charges at the encounter level: 

1. From the Encounters view, right-click the item or click View Menu and select Move Charges.  
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2. List view  

 

 
3. Detail view  
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4. The person search window is displayed.  

 

 
5. Search and select the person and encounter to which you want to move charges. 
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6. Click Select to move the charges to the selected person.  

 

 
7. In the Charges view for the encounter, moved charges are in a Credited status. The credited charge is now a debit charge on 

the encounter where the charge was moved to. Note that the only way to see the differences in the charges moved is the 

encounter column within the Charges view.  
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CHARGE LEVEL 

The Charges view allows for multiple selections at once and the Move Charge task can be applied to all of them. To select several 

single items, hold down the CTRL key and click each item. To select several items that are all grouped together, hold down the SHIFT 

key and click the top item, then click the bottom item. These can be used together to select a set of charges (using SHIFT) and then 

deselect certain charges from that range (using CTRL). 

1. In the Charges view for the encounter, right-click charge and select Move Charges.  

 

 
2. Search and select the person and encounter that you want to move charges. 

3. Click Select to move the charges to the selected person. 

4. In the*Charges* view, verify that the charges are moved successfully. The moved charges are displayed in a Credited status. 

The credited charge is now a debit charge on the encounter where the charge was moved to. Note that the only way to see 

the differences in the charges moved is the encounter column within the Charges view.  

5. Combines 

6. Combining Financial Encounters 

A financial combine allows you to bill two encounters together without modifying or updating the clinical encounters. A 

common example is the Medicare 72 hour rule. In that case, medically-related encounters within 72 hours of each other must 

be billed together.  

 

You can access this task from the Encounters view. It is disabled if the patient does not have more than one financial encounter 

for the same billing entity or if the patient has been discharged.  

NOTE: CERNER DOES NOT RECOMMEND USING FINANCIAL COMBINE OR UNCOMBINED FOR NEWBORN/MOTHER 

BABY WORKFLOWS. CERNER RECOMMENDS USING THE “MOVE CHARGE” FUNCTIONALITY. 
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COMBINE ENCOUNTERS 

Complete the following steps to combine encounters: 

1. In the Encounters view, right-click an encounter, and select the View Menu.  

2. Select Financial Combine. A Financial Combine dialog box window opens. It displays the encounter you selected in Step 1 as 

Encounter A. It displays a list of potential encounters in Encounter B. If the patient has more than one additional encounter 

on record, select the encounter from the Encounter B list.  

NOTE: MULTISELECT FUNCTIONALITY — YOU CAN SELECT YOUR FROM AND TO ENCOUNTERS FROM THE ENCOUNTERS 

VIEW LIST. SELECT BOTH OF YOUR ENCOUNTERS. RIGHT-CLICK AND SELECT FINANCIAL COMBINE. BOTH ENCOUNTERS 

WILL BE DISPLAYED IN THE DIALOG BOX.  

3. Select whether you need to move Encounter A into Encounter B or vice versa. 

Below are the attributes that are displayed for both encounters selected:  

 

Encounter: FIN, Begin Date - End Date 

Person Name 

Account: MRN 

Type: Encounter Type 

Status 

Patient Location 

Financial Class 

Health Plan 

Total Balance 

Primary Diagnosis Code  

 

 



161 
 

4. After selecting the combination, a message displays prompting you to confirm your decision. Click Yes to proceed with the 

financial combine.  

 

 

NOTE: THE BALANCE OF THE TO ENCOUNTER NOW EQUALS THE BALANCE OF THE TO ENCOUNTER PLUS THE SUM OF 

ALL THE CHARGES ON THE FROM ENCOUNTER MINUS PAYMENTS AND MINUS ADJUSTMENTS ON THE FROM 

ENCOUNTER. AFTER THE FINANCIAL COMBINE THE FROM ENCOUNTER WILL GET INACTIVATED. THE TO ENCOUNTER 

STATUS WILL NOT BE MODIFIED.  

 

The following views can be affected by a financial combine:  

• Balances 

• Claims 

• Statements 

• Charges 

• Self Pay Transactions 

• Insurance Transactions 

• Encounters 

Activities: The combine activity will get added. 

• Related encounters 

• Patient Account Workflow 

• Billing Holds 

• Correspondence 

• Comments  

UNCOMBINING FINANCIAL ENCOUNTERS 

The Financial Uncombine task allows you to reverse any previous financial encounter combine.  

The task is disabled if:  

• a financial combine has not occurred previously on the selected financial encounter. 

• a clinical encounter combine is performed.  

Complete the following steps to reverse a financial combine:  

1. Access the Encounter tab on the affected encounter. 

2. Right-click the encounter, and select the View Menu. 
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3. Select Financial Uncombine. 

• Select the additional encounter for the uncombine in the drop down available from the Encounter box on the Encounter B 

side of the dialog. This drop-down menu will only be active if more than two financial encounters were combined into one.  

 

Below are the attributes that are displayed for both encounters selected:  

 

Encounter: FIN, Begin Date, End Date 

Person Name 

Account: MRN 

Type: Encounter Type 

Status 

Patient Location 

Financial Class 

Health Plan 

Total Balance 

Primary Diagnosis Code  

 

 

4. Click Uncombine. A message is displayed indicating that the uncombined function was successful.  

NOTE:  THE FOLLOWING TABS CAN BE AFFECTED BY A FINANCIAL UNCOMBINE: 

• Balances 

• Claims 

• Statements 

• Charges 

• Self Pay Transactions 
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• Insurance Transactions 

• Encounters 

Activities: The combine activity will get added. 

• Related encounters, 

• Patient Account Workflow 

• Billing Holds 

• Correspondence 

• Comments 

• Account Payable (AP) Refunds 

There are several options for creating refunds. They can be issued to an Insurance Payer, Guarantor, Patient, or another party. The 

information below outline the options you have for creating refunds. 

CREATING A REFUND AT THE BALANCE LEVEL  

You can create a refund on an insurance balance. 

1. Select the appropriate balance. 

2. From the View menu, select Create AP Refund. The Create AP Refund dialog box is displayed. 

 

 
3. Enter the appropriate recipient information. 

Element Description 

Element Description 

Name When you create a refund on an insurance balance, the default recipient of the refund is Insurance, and you cannot 

modify this information. 
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Element Description 

Element Description 

Address When you create a refund on an insurance balance, the insurance company's address is entered by default. You can 

modify this information as needed. 

City You can modify this information as needed. 

State You can modify this information as needed. 

ZIP 

Code 

You can modify this information as needed. 

Country You can modify this information as needed. 

Enter the appropriate refund information. 

Element Description 

Element Description 

Claim Number The claim number associated with the insurance balance. If the balance has more than one claim, select the 

correct claim from the list. 

Reference 

Identifier 

The reference identifier is not required. 

Reason A reason is required. 

Transaction 

Alias 

A transaction alias is required. 

Refundable 

Amount 

The system enters the refundable amount by default. 

Refund 

Amount 

The system enters the refund amount by default. You can modify this amount, but the refund amount cannot 

exceed the refundable amount. 

Remaining 

Amount 

As you modify the refund amount, the system recalculates the remaining amount on the insurance balance. If 

additional refunds are created on the balance at a later date, the system uses the remaining amount still on 

the balance.  
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4. Click OK to create the refund. 

  

REFUND VIEW 

 

All refunds created for an individual encounter are displayed in the Refunds view. In the example below, the Date, Status, Receiving 

Name, and Amount are displayed.   
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Attributes 

The following attributes are available: 

• Date 

• Status 

• Receiving Name 

• Amount 

Type: When displayed in the preview and detail panes, clicking the information icon reveals the types of transactions that make up 

the refund amount. 

• Address 1 

• Address 2 

• Cancel Reason 

• City 

• Comments 

• Country 

• Employer Name 

• Phone 

• Plan Name 

• Refund ID 

• Refund Reason 

• Sponsor Name 

• State 

• Zip Code 

REFUND STATUS FROM PATIENT ACCOUNTING (CPA) 

The following are statuses available from Patient Accounting: 

• Created: Refund is created. 

• Denied: Refund is denied by manager or supervisor. 

• Cancelled: Refund is cancelled. (Cancelled action can only occur on refunds in Created, Approved or Submitted status.) 

• Approved: Refund is approved by manager or supervisor. 
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• Submitted: Refund is approved and submitted. 

• Void Requested: Request for refund to be voided. (This function is only available if you have void options available and 

communication with Accounts Payable (AP) system.) 

• Void Submitted: Request for Void is submitted. (This function is only available if you have void options available and 

communication with AP system.) 

 

REFUND STATUS FROM ACCOUNTS PAYABLE SYSTEM (AP)  

 

The following are statuses received back into CPA from an AP system.  

• Check Cut: Check has been sent out. 

• Check Cashed: Check is cashed. 

Voided: The void requested is successful and the check has been voided in the AP system. (This function is only available when you 

have void options available and communication with AP system.  
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Refunds view for Managers and Supervisors  

 

From the My Workflow perspective, managers and supervisors can view refunds created by their direct reports by double-clicking a 

user's name. The Refunds view is displayed with the refunds created by that user.  

 

 

CREATING A REFUND FOR A TRANSACTION 

You can refund whole or partial amounts of an original transaction. 

1. From the appropriate transaction view, right-click the transaction and select Apply Refund.  
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2. In the Apply Refund dialog box, select the appropriate option, and then click OK. If the transaction was processed by 

an electronic data interchange (EDI) service other than Cerner, the following options are available: 

3. Create AP Refund on the Transaction: Select this option to create a refund. 

4. Reverse the Payment Processed by a Third-Party Credit Card Service and Create AP Refund for the Remaining 

Transaction(s): Select this option to reverse the payment and create a refund. 

5. Reverse the Payment Processed by a Third-Party Credit Card Service: Select this option to reverse the payment without 

creating a refund.  

 

 
6. Select the appropriate payment information and refund amount. The maximum refundable amount for each payment type 

is displayed by default. As you increase or decrease the refund amount, the system recalculates the refundable amount for 

each payment type and the maximum refundable amount. 
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7. Enter a refund reason and specify the recipient. You can select either the guarantor or the patient, or you can specify 

another recipient.  
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8. Enter additional refund details as appropriate. If you selected the guarantor or patient as the recipient, the name and 

address are entered by default. If necessary, you can change the address. If you selected a recipient of Other, you must 

enter all recipient information manually. For credit card refunds, you are not required to enter the recipient's address, 

because the transaction is processed through the third-party credit card service. 
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9. Select the appropriate transaction alias for the refund, and then click OK. The refund is applied for the transaction. 

APPLYING A COMMENT TO A REFUND 

1. In the Refunds view, right-click an appropriate refund and select Apply Comment.  

 

 
2. In the Apply Comment dialog box, select a defined comment or enter a free text comment in the Apply Comment dialog 

box.  

 

 
3. Click Apply to save the comment. The comment can be seen in the Timeline view. 
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APPLYING AN IMMEDIATE REFUND 

NOTE: THE IMMEDIATE REFUND OPTION IS AVAILABLE FOR CASH DRAWER SITUATIONS ONLY. 

Complete the following steps to process an immediate refund: 

1. Click Apply Refund. The Refund dialog box is displayed. 

2. Select the Immediate Refund option. (If the option is not selected, the refund amount will not be reflected in the Self-Pay 

Transactions view or in the Balances view.)  
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3. Select a reason for the refund from the Reason list, and enter the refund amount in the Refund Amount box.  

 

 
4. If appropriate, adjust the refund amount by changing the amount in the Refund Amount box.  
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5. Verify that information is entered correctly and click OK.  

 

 
6. Verify that the applied refund is displayed correctly. The Refunds view displays a status of Complete. The Self-Pay 

Transactions view displays a red X in place of the green check mark for the refunded transaction.  

 

 

 

CANCELING REFUNDS 

 

You can cancel refunds when they are in a Created, Approved, or Submitted status. 

Complete the following steps to cancel a refund:  

1. Right-click the refund, or open the View menu, and select Cancel Refund. The Cancel Refund dialog box is displayed. 



176 
 

2. From the Reason for Cancellation list, select a reason. 

3. Click Cancel Refund. The refund is displayed in the Refunds view with a status of Canceled.  

 

 

MODIFYING A REFUND 

 

You can modify a refund when appropriate. Complete the following steps to modify a refund:  

1. In the Refunds view, right-click the appropriate refund and select Modify Refund. The Modify Refund dialog box is 

displayed.  

 

Modify Refund task 
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Modify Refund dialog box 

 

  

2. Modify the appropriate attributes and click OK. Changes are saved. (If the Modify Refund button is unavailable, the refund 

is not in a status which allows the refund to be modified). 

ASSIGNING ENCOUNTERS TO COLLECTIONS 

Encounters move through statement cycles set-up for your facility. When an encounter moves past the Past Due Self-Pay work 

queue, it is either submitted to a collection agency or routed to a site-defined Collection Preview queue for approval. Sometimes, 

you may need to assign an encounter to collections outside of this workflow.  

Complete the following steps to manually assign an encounter to collections: 

1. From the Encounter view, click View Menu , and select Assign to Collections. The Collection Agency Assignment dialog 

box opens. 
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NOTE: THIS OPTION IS UNAVAILABLE IF THE ENCOUNTER HAS HOLDS OR IF THE ENCOUNTER IS ALREADY ASSIGNED 

TO A COLLECTIONS OR PRE-COLLECTION AGENCY. 

   

2. Select a collection agency from the Current Collection Agency. The Agency Aliases box opens. 

   

 
   

NOTE: IF THE COLLECTION AGENCY IS SET UP TO SEND ENCOUNTERS TO BAD DEBT, THE ENCOUNTER IS SENT TO BAD 

DEBT AND WRITTEN OFF AUTOMATICALLY.    
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3. Click OK. 

   

 
4. Access the Self Pay Transactions tab. Verify that a bad debt write-off has taken place.  

 

 
   

For additional information on collections agency activity, click the information button in the Encounters details next to “Collection 

Agency”. Use this information for an account follow-up. 
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QUICK REFERENCE GUIDE 
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END 

 


